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Notice

1.

12.

13.
14.

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of
these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or
other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or
others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space system;
undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims
any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is
inconsistent with any Renesas Electronics data sheet, user’'s manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but not
limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH RESPECT
TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO THE IMPLIED
WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user’'s manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products
are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily injury,
injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as safety
design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging
degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.

. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas

Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.

. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is

prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled

subsidiaries.

(Note2) “Renesas Electronics product(s)’ means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Corporate Headquarters Contact information
TOYOSU FORESIA, 3-2-24 Toyosu, For further information on a product, technology, the most up-to-date
Koto-ku, Tokyo 135-0061, Japan version of a document, or your nearest sales office, please visit:

www.renesas.com

www.renesas.com/contact/.
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and measurement
tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor devices must not be
touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.

2. Processing at power-on
The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LS| are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins in
a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the level
at which resetting is specified.

3. Input of signal during power-off state
Do not input signals or an 1/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or 1/0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal elements.
Follow the guideline for input signal during power-off state as described in your product documentation.

4. Handling of unused pins
Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal
become possible.

5. Clock signals
After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal produced
with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.

6. Voltage application waveform at input pin
Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between Vi. (Max.)
and Vin (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the input level
is fixed, and also in the transition period when the input level passes through the area between Vi (Max.) and Vi4 (Min.).

7. Prohibition of access to reserved addresses
Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these
addresses as the correct operation of the LS| is not guaranteed.

8. Differences between products
Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms of
internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.



Disclaimer

By using this Renesas Starter Kit (RSK), the user accepts the following terms:

The RSK is not guaranteed to be error free, and the entire risk as to the results and performance of the RSK is
assumed by the User. The RSK is provided by Renesas on an “as is” basis without warranty of any kind whether
express or implied, including but not limited to the implied warranties of satisfactory quality, fithess for a particular
purpose, title and non-infringement of intellectual property rights with regard to the RSK. Renesas expressly
disclaims all such warranties. Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data,
loss of contract, loss of business, damage to reputation or goodwill, any economic loss, any reprogramming or recall
costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any other
direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this RSK, even
if Renesas or its affiliates have been advised of the possibility of such damages.

Precautions

The following precautions should be observed when operating any RSK product:

This Renesas Starter Kit is only intended for use in a laboratory environment under ambient temperature and humidity
conditions. A safe separation distance should be used between this and any sensitive equipment. Its use outside the
laboratory, classroom, study area or similar such area invalidates conformity with the protection requirements of the
Electromagnetic Compatibility Directive and could lead to prosecution.

The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular installation. If this
equipment causes harmful interference to radio or television reception, which can be determined by turning the
equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures;

e ensure attached cables do not lie across the equipment

e reorient the receiving antenna

e increase the distance between the equipment and the receiver

e connect the equipment into an outlet on a circuit different from that which the receiver is connected
e power down the equipment when not in use

e consult the dealer or an experienced radio/TV technician for help NOTE: It is recommended that wherever
possible shielded interface cables are used.

The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the
following measures be undertaken;

e The user is advised that mobile phones should not be used within 10m of the product when in use.
e The user is advised to take ESD precautions when handling the equipment.

The Renesas Starter Kit does not represent an ideal reference design for an end product and does not fulfil the
regulatory standards for an end product.




How to Use This Manual

1. Purpose and Target Readers

This manual is designed to provide the user with an understanding of how to use Application Leading Tool
(Smart Configurator) for RX together with the CS+ IDE to create a working project for the RSK platform. It is
intended for users designing sample code on the RSK platform, using the many different incorporated
peripheral devices.

The manual comprises of step-by-step instructions to generate code and import it into CS+, but does not
intend to be a complete guide to software development on the RSK platform. Further details regarding
operating the RX660 microcontroller may be found in ‘RX660 Group User’s Manual: Hardware’ and within the
provided sample code. The setup procedure for the RSK installer is described in the Quick Start Guide.

Particular attention should be paid to the precautionary notes when using the manual. These notes occur within the body
of the text, at the end of each section, and in the Usage Notes section.

In this manual, the display may differ slightly from screen shots. There is no problem in reading this manual.

The revision history summarizes the locations of revisions and additions. It does not list all revisions. Refer to the text of
the manual for details.

The following documents apply to the RX660 Group. Make sure to refer to the latest versions of these
documents. The newest versions of the documents listed may be obtained from the Renesas Electronics Web
site.

Document Type Description Document Title Document No.
User’s Manual Describes the technical details of the RSK Renesas Starter Kit for R20UT5017EG
hardware. RX660 User’s Manual
Tutorial Manual Provides a guide to setting up RSK Renesas Starter Kit for R20UT5018EG
environment, running sample code and RX660 Tutorial Manual
debugging programs.
Quick Start Guide Provides simple instructions to setup the RSK Renesas Starter Kit for R20UT5019EG
and run the first sample. RX660 Quick Start Guide
Smart Configurator Provides a guide to code generation and Renesas Starter Kit for R20UT5020EG
Tutorial Manual importing into the CS+ IDE. RX660 Smart Configurator
Tutorial Manual
Schematics Full detail circuit schematics of the RSK. Renesas Starter Kit for R20UT5016EG
RX660 Schematics
Hardware Manual Provides technical details of the RX660 RX660 Group User’s RO1UH0937EJ
microcontroller. Manual: Hardware




2. List of Abbreviations and Acronyms

Abbreviation Full Form
ADC Analog-to-Digital Converter
API Application Programming Interface
bps bits per second
CMT Compare Match Timer
COM COMmunications port referring to PC serial port
CPU Central Processing Unit
E1/E2 Lite Renesas On-chip Debugging Emulator
GUI Graphical User Interface
IDE Integrated Development Environment
IRQ Interrupt Request
LCD Liquid Crystal Display
LED Light Emitting Diode
LSB Least Significant Bit
LVD Low Voltage Detect
MCU Micro-controller Unit
MSB Most Significant Bit
PC Personal Computer
PLL Phase-locked Loop
Pmod™ Thig is a Digilent Pmod™ ngpatible connector. Pmod™ is registered to Digilent Inc.
Digilent-Pmod_Interface Specification
PSU Power Supply Unit
RAM Random Access Memory
ROM Read Only Memory
RSK Renesas Starter Kit
RTC Real Time Clock
SCI Serial Communications Interface
SPI Serial Peripheral Interface
TFT Thin Film Transistor
UART Universal Asynchronous Receiver/Transmitter
USB Universal Serial Bus
WDT Watchdog Timer

All trademarks and registered trademarks are the property of their respective owners.


https://reference.digilentinc.com/reference/pmod/specification?redirect=1
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LENESAS

1. Overview

1.1 Purpose

This RSK is an evaluation tool for Renesas microcontrollers. This manual describes how to use the CS+ IDE
Smart Configurator to create a working project for the RSK platform.

1.2 Features

This RSK provides an evaluation of the following features:
« Project Creation with CS+

« Code generation using the Smart Configurator.
« User circuitry such as switches, LEDs and a potentiometer

The RSK board contains all the circuitry required for microcontroller operation.

R20UT5020EG0100 Rev.1.00 o
Jan.17.2022 RENESAS



Renesas Starter+ Kit for RX660 2. Introduction

2. Introduction

This manual is designed to answer, in tutorial form, how to use the Smart Configurator for the RX family
together with the CS+ IDE to create a working project for the RSK platform. The tutorials help explain the
following:

e Project generation using the CS+

e Detailed use of the Smart Configurator for CS+
¢ Integration with custom code

e Building the project CS+

The project generator will create a tutorial project with three selectable build configurations:
o ‘DefaultBuild’ is a project with debug support and optimisation level set to two.
o ‘Debug’ is a project built with the debugger support included. Optimisation is set to zero.

¢ ‘Release’ is a project with optimised compile options (level two) and no ‘Outputs debugging information’
options not selected, producing code suitable for release in a product.

The tutorial examples in this manual assume that installation procedures described in the RSK Quick Start
Guide have been completed. Please refer to the Quick Start Guide for details of preparing the configuration.

These tutorials are designed to show you how to use the RSK and are not intended as a comprehensive introduction to
the CS+ debugger, compiler toolchains or the E2 emulator Lite. Please refer to the relevant user manuals for more in-
depth information.

R20UT5020EG0100 Rev.1.00 o
Jan.17.2022 RENESAS




Renesas Starter Kit for RX660

3. Project Creation with CS+

3. Project Creation with CS+

3.1 Introduction

In this section, the user will be guided through the steps required to create a new C project for the RX660

MCU, ready to generate peripheral driver code using Smart Configurator.

This project generation step is

necessary to create the MCU-specific project and debug files.

3.2 Creating the Project

To use the program, start CS+:

Windows™ 8.1: From Apps View @ click ‘CS+ for CC (RL78,RX,RH850) icon
Windows™ 10/ 11: Start Menu > All Apps > Renesas Electronics CS+ > CS+ for CC (RL78,RX,RH850)

e CS+ will show the Start Page. Use

Create New Project

13 ) A j be ed.
the' GO bUtton to Create a NeW Azzxg:gixz:: alsgr;:tcreated by reusing the file configuration registered to an existing project.
Project.
e In the ‘Create Project’ dialog, select Create Project X
‘RX’" from the ‘Microcontroller’ pull-
d own. Microcontroller: R v
e In the ‘Using Microcontroller’ list Using microcontroller:
COﬂtrOl, scroll down to ‘RX660 and & (Search microcontroller) Update...
expanq the tree control by CI!Ck,'ng +. M REF56609EFE(144pin) ~ | | Product Name:R5F56603HxFB
Select ‘R5F56609HxFB (144pin)’. 3 R5F5E509EFP(100pin) On-chip ROM size[KBytes]: 1024
. o L, W RSF5E609FxFE(144pin) TuEr e ETEIHRITE
° Ensure that in the ‘Kind of prOJeCt pU”' W REF56505FxFP(100pin) Addttional Information:Package=FLOP0144KA-B
down, ‘Application(CC-RX)’ is selected. : g?i:gggggxigﬂﬁvmﬁ
E ¥ pin
e Choose an appropriate name and . RO 56609HxFB(144pin) |
location for the project, then click W REFSEE0SHFP(100pin) v
‘Create’.
. . i Kind of project: Application{CC-RXx) v
Note: this tutorial assumes the project _
is named and located at the place Project name: SC_Tutoral
shown OppOSite. Place: Ciwlorkspace ~| | Browse..
e Ifthe fplder gntered qannot bg found a Make the project folder
‘Question’ dialog will be displayed; , , — —
. , y C\workspace\SC_Tutorial\SC_Tutorial mtpj
click 'Yes’.
[ Pass the file composition of an existing project to the new project
Project to be passed: Browse. ..
Copy composition files in the diverted project folder to a new project folder.
e CS+ will create the blank project with @3 SC_Tutorial - C5+ for CC - [Project Tree]
the standard project tree. A ‘Smart File Edit View Project Build Debug Tool Window Help
Configurator’ node may also be B s [ E G X B B0 O E B = =

shown, if previously enabled.

SHE TR 023 Q8
2| Project Tree o x Property

9.3 @

f‘ Solution List

i

L\I Smart Configurator Property

+ Product Information
‘Version

+~ Smart configurator seling

Smart Configurator for RX executable file path

a
Z
=k

_T% 5C Tutorial (Project)*
: R5F56605H%FB (Microcontroller)

Smart Configurator (Design Tool)
4, CC-RX (Build Toal)

22, RX Simulator (Debug Tool)

r\‘) Program Analyzer (Analyze Tool)

-3l File

|EnUEYy HBWG

R20UT5020EG0100 Rev.1.00
Jan.17.2022
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Renesas Starter Kit for RX660 4. Smart Configurator Using the CS+

4. Smart Configurator Using the CS+

4.1 Introduction

The Smart Configurator for the RX660 has been used to generate the sample code discussed in this
document. Smart Configurator for CS+ is a tool for generating template ‘C’ source code and project settings
for the RX660. When using Smart Configurator, it provides the user with a visual way of configuring the target
device, clocks, software components, hardware resources and interrupts for the project. Thereby bypassing
the need in most cases to refer to sections of the Hardware Manual.

By following the steps detailed in this tutorial, the user will generate a CS+ project called SC_Tutorial. A fully
completed Tutorial project is contained in the RSK Web Installer

(https://www.renesas.com/rskrx660/install/cs) and may be imported into CS+ by following the steps in the
Quick Start Guide. This tutorial is intended as a learning exercise for users who wish to use the Smart
Configurator to generate their own custom projects for CS+.

Once the user has configured the project, the ‘Generate Code’ function is used to generate three code
modules for each specific MCU feature selected. These code modules are named ‘Config_xxx.h’,
‘Config_xxx.c’, and ‘Config_xxx_user.c’, where ‘xxx’ is an acronym for the relevant MCU feature, for example
‘S12AD’. Within these code modules, the user is then free to add custom code to meet their specific
requirement. However, these files require custom code to be added between the following comment
delimiters:

/* Start user code for adding. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Smart Configurator will locate these comment delimiters, and preserve any custom code inside the delimiters
on subsequent code generation operations. This is useful if, after adding custom code, the user needs to re-
visit Smart Configurator to change any MCU operating parameters.

Note: If code is added outside the above user code area, it will be lost if code generation is executed again
with Smart Configurator.

The SC_Tutorial project uses interrupts for switch inputs, the ADC module, the Compare Match Timer (CMT),
the Serial Communications Interface (SCI) and uses these moddules to perform A/D conversion. Results are
displayed via the virtual COM port in a terminal program and also on the PMOD display connected to the RSK.

Following a tour of the key user interface features of Smart Configurator in the tabbed pages (board, clocks,
components and pins), as well as a demonstration of building a project, the reader is guided through each of
the peripheral function configuration pages and familiarised with the structure of the template code, including
the process of adding their own code to the user code areas provided by the Smart Configurator.

R20UT5020EG0100 Rev.1.00 RENESAS Page 11 of 71
Jan.17.2022
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Renesas Starter Kit for RX660 4. Smart Configurator Using the CS+

4.2 Project Configuration using Smart Configurator

In this section, a brief tour of Smart Configurator is presented. For further details of the Smart Configurator
paradigm and reference, refer to the RX Smart Configurator User's Guide: CS+.
You can download the latest document from: https://www.renesas.com/smart-configurator.

Smart Configurator will start up by double clicking on “Smart Configurator (Design Tool)” in the project tree.
RTOS configuration dialog will only appear once, on the first instance that smart configurator is opened. It will
appear as illustrated below in Figure 4-1. This project does not use RTOS, so press the ‘Finish’ button.

E& New Smart Configuration File O >

Smart Configuration Settings
Select RTOS and RTQOS version

RTOS: None L
RTOS Version:

Manage RTOS Versions..

Figure 4-1 RTOS setting dialog

The Smart Configurator initial view is displayed as illustrated in Figure 4-2.

& Smart Configurator - m} x
File Window Help

) SC_Tutorialscfg x = 0 || MCU/MPU Package % el

Overview information L-HE PP ® Assigned (- Default Board

= General Information

Overview Application Code
Get an gverview of the features provided by

w
3
Smart Configurator. o
Sof‘twar% Components ) 3 (/\)
| Middieware & o) Jv
Drivers
: B
g
i = - E
What's New MCU Hardware
R

Check out what's new in the latest release.

= Current Configuration

Selected board/device: RSF56609HxFB (ROM size: 1 MB, RAM size: 128 KB, Pin count: 144)

Generated location (PROJECT_LOCY): |src¥sme_gen Edit

Selected components:

Companent Version Configuration

® Board Support Packages. (r_bsp) 720 r_bsplused) '
Overview Board Clocks System Components| Pins Interrupts » Legend
© Console x T B~ = 0 82 I-vasFivy % i=n
No consoles to display at this time. 0 items

Description Type

Figure 4-2 Overview page

Smart Configurator provides GUI features for configuration of MCU sub systems. Once the user has
configured all required MCU sub systems and peripherals, the user can click the ‘Generate Code’ button,
resulting in a fully configured CS+ project that builds and runs without error.
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4.3 The ‘Board’ tabbed page

On the ‘Board’ tabbed page, set the board type and device type.
Click the 'Board' tab and it will be displayed as shown in Figure 4-3.

& 8 L.'J bl
Device selection Generate Code Generate Report
Device selection B

Board: Custom User Board v

Device: RSF56609HxFB

Ovewie(locks System Components Pins| Interrupts

Figure 4-3 The ‘Board’ tabbed page

4.31 Board configuration

Make sure that ‘Custom User Board’ is selected for the ‘Board:’.

Device selection

Device selection

Board: Custom User Board v

Device: RSF36609HxFB

Figure 4-4 Select board
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4.4 The ‘Clocks’ tabbed page

The ‘Clocks’ tabbed page configures clocks of the device selected. Clock source, frequency, PLL settings and
clock divider settings can be configured for the output clocks. Clock configurations will be reflected to
‘r_bsp_config.h’ file in ‘Smart Configurator\r_config’ of project tree.

441 Clocks configuration

Figure 4-5 shows a screenshot of Smart Configurator with the Clocks configurations. Click on the ‘Clocks’ tab.
Configure the system clocks as shown in the figure. In this tutorial, we are using the on-board 24 MHz crystal
resonator for our main clock oscillation source and the PLL circuit is in operation. The PLL output is used as
the main system clock and the divisors should be set as shown in Figure 4-5.

Clocks configuration | =

Generate Code Generate Report

SCKCR (FCK[3:0]) FlashiF clock (FCLK)
C A (Actual value: 3.3 roroT o (MHz
Frequency Division: SCKCR (ICK[3:07) System clock (ICLK)
D I lE = — S
-‘a in clock 5 i SCKCR (PCKA[3:0]) Peripheral module clock (PCLKA)
Frequency Multiplication: .
Oscillation source: | Resonator - p x1/2 x 120 (MHz)
X100 -
SCKCR (PCKB[3:07) Peripheral module cock {PCLKE!
Frequency: 24 MHZ) % = [3:0] P J k )
p— xi/4 - 60 (MHz)
Oscillation wait time: P ic
SCKCR (PCKD[3:07) Peripheral module dock (PCLKD)
9980 (1s) (Actual value: 10000)
> x1/4 - 60 (MHz)
SCKCR (BCK[3:0]) External bus clock (BCLK)
p— x1/4 - 5 60 (MHz)
Sub-clock
BCKCR (BCLKDIV)
SCKCR2 (CFDCK[3:0]) CANFD clock (CANFDCLEK)
L— x4 - 60 [MHz)
CANFDMCLK/CACMCLE
HOCO clack 24 (MHz)
LOCO clock
'WDT-dedicated clock

Overview Boaldystem Components| Pins Interrupts
Figure 4-5 The ‘Clocks’ tabbed page
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4.5

The ‘System’ tabbed page

Set the On-chip debug setting mode on the ‘System’ tabbed page.

4.51

& SC_Tutorial scfg =

System configuration

=

= On-chip debug setting

Debugger type setting (Board development mode)
Emulator Unused i

Mote: This setting is used to specify the default on-chip debugger selection in the debugger setting
Debug interface setting

(O Unused (O FINE (@) JTAG () JTAG (Trace)

Mote: The using of PC7/UB may have a limitation, because PC7/UB is controlled for mode-settings by emulator

Overview Board Clocksl System I(omponenls Pins | Interrupts

-
Tl =

Generate Code Generate Report

Figure 4-6 The ‘System’ tabbed page

On-chip debug setting

select as shown in Figure 4-7.

The On-chip debug settings set emulator and interface used for debugging. For the RSKRX660 CPU board,

* On-chip debug setting
Debugger type setting (Board development mode)

Emulator Renesas E2 Lite

Mote: This setting is used to specify the default on-chip debugger selection in the debugger settings.

Debug interface setting

(O Unused (®) FINE I O ITAG () JTAG (Trace)

MNote: The using of PC7/UB may have a limitation, because PC7/UB is controlled for mode-settings by emulator

Figure 4-7 On-chip debug setting
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4.6 The ‘Components’ tabbed page

Drivers and middleware are handled as software components in Smart Configurator. The ‘Components’ page
allows the user to select and configure software components.

Software component configuration

Components =] - Configure
W
type filter text
v (= Startup
w = Generic
& rbsp

Overview | Board | Clocks | System EComponent;! Pins | Interrupts
Figure 4-8 Components page

4.6.1 Add a software component into the project

Smart Configurator supports four types of software components: Startup, Drivers, Middleware and Application.
In the following sub-sections, the reader is guided through the steps to configure the MCU for a simple project
containing interrupts for switch inputs, timers, ADC and a SCI by component of Drivers.

Click the ‘Add component’ & icon.

Software component configuration

Components = = -

[els

type filter text

w [= Startup
v [= Generic

& rbsp

Figure 4-9 Add a Software component (1)

In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.

E& Mew Component O ht

Software Component Selection t!j'

Select component from those available in list

Category |All ~
All

lamio

Function

Filter

Figure 4-10 Add a Software component (2)
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4.6.2 Compare Match Timer

CMTO will be used as an interval timer for generation of accurate delays. Select ‘Compare Match Timer’ as
shown in Figure 4-11 below then click ‘Next’.

G New Component [m} * ‘
Software Component Selection tB
Select component from those available in list
Category IDrivers vI
Function |All ~
Filter |
Components - Short Name Type Version
8 8-Bit Timer Code Generator  1.9.0
8 Clock Frequency Accuracy Measurem... Code Generator 1100
L Code Genaratar 181
B Compare Match Timer Code Generator 2.2.0 I
B Complementary PWM Mode Timer Code Generator 1,100
8 Continuous Scan Mode S12AD Code Generator  1.12.0
# CRC Calculator Code Generator 1,100
8 D/A Converter Code Generator 1,100
# Data Operation Circuit Code Generator  1.10.0
B8 Data Transfer Controller Code Generator  1.10.0
8 Dead-time Compensation Counter Code Generator 1,100
| B8 DMA Controller Code Generator 170 V|
Show only latest version
Hide items that have duplicated functionality
Description
| This software component provides configurations for 16-bit/32-bit timer with module |
CMT/CMTW and can generate interrupts at set intervals.
Download the latest FIT drivers and middieware
Configure general settings...
@ < Back I Next > I [ Finish | Cancel

Figure 4-11 Compare Match Timer

Ensure that the ‘Configuration name’ updates to ‘Config_ CMTO’ as shown in Figure 4-12 below then click
‘Finish’.

m New Component O X ‘

Add new configuration for selected component ‘H:f

Compare Match Timer

Configuration name: ICanig_C MTO I

Resource: CMTO o

coo | [ e ][ conce

Figure 4-12 Ensure Configuration name - CMTO0
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In ‘Config_CMTO0’, configure CMTO as shown in Figure 4-13. This timer is configured to generate a high
priority interrupt every 1ms. We will use this interrupt later in the tutorial to provide an API for generating high
accuracy delays required in our application.

K [m] x
4 *SC_Tutonal.scfg % S

e &

Software component configuration Generate Code Generate Report

Components el i 5 @ 3+  Configure @
e ing
|type fiiter text @ PCLK/B O PCLK/32 (O PCLK/128 O PCLK/S12
v & Startup ~ Compare match setting
v (& Generic Interval value Il I Irns v I,‘\c:u.;l value: 1)
& rbsp : " =
v & Drivers egister value (CMCOR) | 7499 |
v & Timers [#] Compare match interrupt (CMIO)
« Config CMTO Pricrity ILE‘\-’BI 10 & I

~

Overview Board Clocks System Components | Pins| Interrupts

Figure 4-13 Config_CMTO setting

CMT1 and CMT2 will be used as timers in de-bouncing of switch interrupts.

Click the ‘Add component’ % icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.
Select ‘Compare Match Timer’ as shown in Figure 4-14 below then click ‘Next'.

EG New Component O * ‘

Software Component Selection tB

Select component from those available in list

Category | Drivers v |
Function | All s
Filter .
Components : Short Name Type Version ~
4 8-Bit Timer Code Generator  1.9.0
8 Clock Frequency Accuracy Measurem... Code Generator 1100
=:4 L Code Generator __1.8.1
I B Com:are Match Timer Code Generator _2.2.0
B Complementary PWM Mode Timer Code Generator 1,100
8 Continuous Scan Mode S12AD Code Generator  1.12.0
8 CRC Calculator Code Generator  1.10.0
8 D/A Converter Code Generator 1,100
# Data Operation Circuit Code Generator  1.10.0
8 Data Transfer Controller Code Generator  1.10.0
# Dead-time Compensation Counter Code Generator 1,100
| B8 DMA Controller Code Generator 170 V|

Show only latest version

Hide items that have duplicated functionality

Description

[ This soﬁ\uare component prowdés con.f.i.guraﬂons for ia'vl':uuiz-'bnr ilﬁ\er w|.th modﬁlé i
CMT/CMTW and can generate interrupts at set intervals.

Download the latest FIT drivers and middieware

Configure general settings...

2 Back Next > Finish | Cancel
Figure 4-14 Select Compare Match Timer
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Ensure that the ‘Configuration name’ updates to ‘Config_CMT1’ as shown in Figure 4-15 below then click
‘Finish’.

ré Mew Component

Add new configuration for selected component

Compare Match Timer

Configuration name: IConflg_C MT1 I
Resource: CMT1 v
Q2 < Back

Figure 4-15 Ensure Configuration name — CMT1

this tutorial.

Navigate to the ‘Config_CMT1’ and configure CMT1 as shown in Figure 4-16. This timer is configured to
generate a high priority interrupt after 20ms. This timer is used as our short switch de-bounce timer later in

omponents = L-I i = h:\- - UI'Ii ure
C t 3 Conf

o Count clock setting
type filter text

@
O PCLK/8 ® PcLk/32 O PCLK/128
~ & Startup ~

v = Generic

OPCLK/s12
Compare match setting
Interval value I 20 I Irns ~ I,'\r_:m value: 20)
@ r_bsp
~ & Drivers Register value (CMCOR) 37499
~ & Timers [#] Compare match interrupt {CMI1)

@ Config_CMTO Priority
« Config_CMT1

ILewnO vI

Figure 4-16 Config_CMT1 setting
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Click the ‘Add component’ % icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.
Select ‘Compare Match Timer’ then click ‘Next’. In ‘Add new configuration for selected component’ dialog ->
Resource, select ‘CMT2’ as shown in Figure 4-17 below.

X

EG New Component O

Add new configuration for selected component t}j

Compare Match Timer

Configuration name: .Config_-C MTWO

Resource:

Figure 4-17 Select Resource — CMT2

@ < Back Cancel

Ensure that the ‘Configuration name’ updates to ‘Config_CMT2’ as shown in Figure 4-18 below then click
‘Finish’.

G Mew Component O x ‘
Add new configuration for selected component t}j
Compare Match Timer
Configuration name: ICcmfig_CMTZ I
Resource: CMT2 e
@ < Back Moo [ Fish | Cancel

Figure 4-18 Ensure Configuration name — CMT2

Navigate to the ‘Config_CMT2’ and configure CMT2 as shown in Figure 4-19. This timer is configured to
generate a high priority interrupt after 200ms. This timer is used as our long switch de-bounce timer later in
this tutorial.

Components el % 2 B3+ Configure @
L Count clock setting
type filter text O PCLK/8 O PCLE/32 O PCLK/128
~ (& Startup ~ Compare match setting
v = Generic Interval value I 200 I Im5 w I,\r_ju.,—\ value: 200.004267
& rbsp
+ @ Drivers Register value (CMCOR) |23437
v & Timers Compare match interrupt (CMI2)
@ Config_CMTO Priority [ tevei 10 M|
« Config CMT1
« Config_ CMT2
Figure 4-19 Config_CMT2 setting
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4.6.3 Interrupt Controller

Referring to the RSK schematic, SW1 is connected to IRQ9(P91) and SW2 is connected to IRQ10 (P92).
SW3 is connected to ADTRGON(PQ7) and. This tutorial uses ADTRGONn, which will be configured later in
section 4.6.7.

Click the ‘Add component’ % icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.
Select ‘Interrupt Controller’ as shown in Figure 4-20 then click ‘Next'.

E6 New Component O X ‘

Software Component Selection t[j

Select component from those available in list

Categoryl Drivers v I
Function | All ~
Filter .

Components : Short Name Type Version *

# Group Scan Mode S12AD Code Generator  1.11.0

#812C Master Mode Code Generator  1.11.0

8 12C Slave Mode Code Generator__1.10.0

# Interrupt Controller Code Generator 220 I

Low Power Consumption Code Generator 220

# Normal Mode Timer Code Generator  1.11.0

# Phase Counting Mode Timer Code Generator 230

# Ports Code Generator 230

B PWM Mode Timer Code Generator  1.11.0

# Real Time Clock Code Generator  1.7.0

# Remote Control Signal Receiver Code Generator  1.1.0
| # SCI/SCIF Asynchronous Mode Code Generator 1110 ¥

Show only latest version
Hide iterns that have duplicated functionality

Description

[ Interrupt Controller configures the interrupt requests generated by ICU: Software interrupt,
NMI pin interrupt and IRQ External pin interrupts.

Download the Iatest FIT drivers and middleware

Configure general settings...

@ Back Next > Finish | Cancel
Figure 4-20 Select Interrupt Controller

In ‘Add new configuration for selected component’ dialog -> Resource, select ‘ICU’ as shown in Figure 4-21
below then click ‘Finish’.

6 New Component [m| X ‘
Add new configuration for selected component t}j
Interrupt Controller
Configuration name: Ik onfig_ICU I
Resource: ICu ™
@ < Back Next > ‘ Cancel

Figure 4-21 Select resource — ICU
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Navigate to the ‘Config_ICU’, configure these two interrupts as falling edge triggered as shown in Figure 4-22
below.

Components el & & 2 v Configure
LR Software intefrupt setting
type filter text [] Software interrupt
v & Startup A [ software interrupt 2
v @ Generic Level 15 (highest)
& rbsp
v & Drivers NMI pin interrupt setting
v & Interrupt ] NMI pin interrupt Falling edge No filter
« Config_ICU
v &= Timers IRQO setting
& Config_CMTO CJwrao Low level No filter
& Config CMT1
115 (hic ,
& Config CMT2 Level 15 (highest
IRQ1 setting
irat Low level No filter
Level 15 (highest)
IRQ2 setting
Oraz Low level No filter
Level 15 (highest)
IRQ3 setting
Oira3 Low level Mo filter
Level 15 (highest)
IRQ4 setting
[Jirg4 Low level Mo filter
Level 15 (highest)
IRQ5 setting
JIrRas Low level No filter
Level 15 (highest
IRQ6 setting
Jras Low level No filter
Level 15 (highest)
IRQ7 setting
Cwra7 Low levet No filter
Level 15 (highest)
IRQS setting
Owras Low tevel No fitter
Level 15 (highest)
IRQY setting
RQB Detection type | Falling edge ~ | Digital filter |No filter ~ 0 MHz
Priority Level 15 (highest) >
IRQ10 setting
ROIO Detection type | Falling edge ~ | Digital filter |No filter ~ 0
Priority Level 15 (highest) ~
IRQ11 setting
Cra11 Low level 3 No filter
Level 15 (highest)
IRQ12 setting
Jirai2 Low level No filter
Level 15 {highest)
IRQ13 setting
Oraz Low level No filter
Level 15 (highest
IRQ14 setting
irai4 Low level No fifter
Level 15 (highest)
IRQ15 setting
Orars Low levei No filter
Level 15 (highest)
v

Figure 4-22 Config_ICU setting

R20UT5020EG0100 Rev.1.00 RENESAS Page 22 of 71
Jan.17.2022



Renesas Starter Kit for RX660 4. Smart Configurator Using the CS+

4.6.4 Ports

Referring to the RSK schematic, LEDO is connected to P17, LED1 is connected to PF5, LED2 is connected to
P04 and LED3 is connected to P06. PJ3 is used as one of the LCD control lines, together with PLO, P71 and
P72.

Click the ‘Add component’ % icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.
Select ‘Ports’ as shown in Figure 4-23 then click ‘Next'.

EE Mew Component O X ‘

Software Component Selection t{:r

Select component from those available in list

Category I Drivers vI
Function | All ~
Filter '

Components : Short Name Type Version

# Low Power Consumption Code Generator 220

# Normal Mode Timer Code Generator  1.11.0

Lode Geperatar 230

i Ports Code Generator  2.3.0 I

& PWM Mode Timer Code Generator  1.11.0

# Real Time Clock Code Generator  1.7.0

8 Remote Control Signal Receiver Code Generator  1.1.0

8 5CI/SCIF Asynchronous Mode Code Generator  1.11.0

# SCI/SCIF Clock Synchronous Mode Code Generator 1110

88 Single Scan Mode 512AD Code Generator  24.0

B Smart Card Interface Mode Code Generator 1110
| # SPI Clock Synchronous Mode (3-wire .. Code Generator 1110 V|

Show only latest version
Hide items that have duplicated functionality

Description

[ This software component provides configurations for General Purpose Input/Output. ~
Common features such as reading, writing, and setting the direction of ports and pins can be
configured. Enabling features such as open-drain outputs and intemal pull-ups are also v |

Download the latest FIT drivers and middleware

Configure general settings...

@ Back I Next > I| Finish | Cancel

Figure 4-23 Select Ports

In ‘Add new configuration for selected component’ dialog -> Resource, select ‘PORT’ as shown in Figure 4-24
below then click ‘Finish’.

6 New Component [m} X ‘
Add new configuration for selected component t{j
Ports

Configuration name: |[Config_PORT

Resource: PORT -

Figure 4-24 Select resource — PORT
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Tick the tickboxes for ‘PORT0Q’, ‘PORT1’, PORT7’, ‘PORTF’, ‘PORTJ and ‘PORTL as shown in Figure 4-25
below.

Components a3 % E B 3+ Configure

ol Port selection PORTO PORT1 PORT7 PORTF PORT! PORTL

[ r
| type filter text

~ = Startup ~
w = Genenc I POHT'DI I PORT1 I
@« r_bsp
e [ poRT2 []PORT3
v & Interrupt ] PORT4 ] PORTS
@ Config_ICU
« & /O Ports [ PORTE PORTT
@ Config_PORT
e 8, TIPsars [ PORTE [JPORTS
Config_CMTO
e ] PORTA [ ]PORTB

& Config_CMT1
@ Config_CMT2 ] PORTC [JrorTD

] PORTE PORTF
] PORTH PORT)
] PORTK PORTL

] PORTN

Figure 4-25 Select Port selection

Navigate through each of the ‘PORTX’ tabs, configuring these four 1/O lines and LCD control lines as shown in
Figure 4-26, Figure 4-27, Figure 4-28, Figure 4-29, Figure 4-30 and Figure 4-31 below. Tick the tickboxes
for ‘Out’ and tick ‘Output 1’ the tickboxes except for P72 under the ‘PORT7’ tab. Start with the 'PORTO' tab.

Components taed % 5 B3+ Configure
_ - : Port selection| PORTO | PORT1 PORT7 PORTF PORT) PORTL
| type filter text
v & Startup ~
Appl Il
v & Genenc 0 PryinS
& 1.bsp Unused GPIO In Qut Pull-up CMOS output Output 1
~ & Drivers
~ & Interrupt P00
& Config_ICU @Unused GPIO O'in O 0Out [JPull-up CMOS output w Output 1 | Nermal drive output
~ & 1/O Ports
« Config_PORT POl
v & Timers ®Unused GPIO Olin - O 0Out [JPull-up  CMOS output ~ Output 1 MNormal drive output
& Config CMTO
& Config_CMT1 PO2
@ Config CMT2 @®uUnused GPI0 Oin Oout [JPull-up  CMOS output v Output 1 INormal drive output
P03
@ Unused GPIO Olin O Out [JPull-up CMOS output v Dutpiit 1
PO4
() Unused GPIO Pull-up  CMOS output ~ | Output 1 | Normal drive output
P05
@®Unused GPIO Oin OOut [JPull-up  CMOS output ~ Output 1
P06
O Unused GPIO Olin Pull-up | CMOS output v | | 4] Output 1
PoT
@Unused PO Oin O out [JPull-up  CMOS output ~ Output 1
Figure 4-26 Select PORTO tab
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Select ‘PORT1’ tab.

Components ed ™ 8 ® 3~ Configure
bl Port selection PORTO | PORT1| PORT7 PORTF PORT) PORTL
type filter text |
v (= Startup ~
e ] Apply to all
& rbsp Unused GFIO In Out Pull-up |CMOS output
w (= Drivers
~ & Interrupt P12
& Config_ICU ®Unused GPIO. O'in O out [JPull-up | CMOS output
v & /O Ports
« Config_PORT P13
v = Timers ®Unused GPIO O'in O 0Ouwt [JPull-up  CMOS output
@ Config_CMTO
@ Config_CMT1 P14
@ Config CMT2 @ Unused GPIO O'in O Out [JPull-up | CMOS output
P15
@ Unused GPIO Oin QOut [JPull-up  CMOS output
P16
®Unused GPIO O'in Oout [JPull-up CMOS output
P17
(O Unused GPIO. (O In Pull-up | CMOS output
Figure 4-27 Select PORT1 tab
Select ‘PORT7 tab.
Components aed ™ 8 ® 3~ Configure
el Port selection PORTO PORT1 | PORT7] PORTF PORT) PORTL
type filter text |
~ (= Startup ~
Appl I
v &= Genenc DlApplyto a
@ rbsp Unused GPIO In Qut Pull-up [CMOS output
~ & Drivers
~ & Interrupt F70
@ Config_icu @®Unused GPIO. O'in OQout [JPull-up  CMOS output
v & /O Ports
« Config_PORT P
v & Timers O Unused GPIO O'ln Pull-up  |CMOS output
& Config CMTO
@ Config_CMT1 P72
& Config CMT2 O Unused GPIO Oin | @ Out Pull-up | CMOS output
P73
@®Unused GPIO Oin Oout [JPull-up  CMOS output
P74
®Unused GPIO O'in Oout [JPull-up  CMOS output
P75
@®Unused GPIO Oin Oout [JPull-up CMOS output
P76
®Unused GPIO Olin O 0Ouwt [JPull-up  CMOS output
P77
®Unused GPIO Oin Oout [JPull-up | CMOS output

Figure 4-28 Select PORT7 tab

L4

Output 1

Output 1

Output 1

Output 1

Output 1

Output 1

Output 1

Output 1

Coutput 1

Output 1

Output 1

Output 1

Output 1

Output 1

Mormal drive output

MNormal drive output

Normal drive output

MNormal drive output  ~

Mormal drive output

Mormal drive output

MNormal drive output

Mormal drive output

MNormal drive output  ~

Mormal drive output

Normal drive output ~

Normal drive output

Mormal drive output

MNormal drive output

Normal drive output -~

MNormal drive output ~
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Select ‘PORTF’ tab.

Components T e

type filter text

L

REE®-

~ & Startup
~ & Generic
@ rbsp
~ & Drivers
~ & Interrupt
@ Config_ICU
~ & /O Ports
« Config_PORT
v = Timers
@ Config_CMTO
@ Config_CMT1
@ Config_ CMT2

Select ‘PORTJ tab.

D

Components e L B

type filter text

- 2p
S

i

w [ Startup
~ & Generic
@ rbsp
v & Drivers
v & Interrupt
@ Config_ICU
~ & /O Ports
« Config PORT
& Timers
& Config CMTO
@ Config_CMT1
@ Config CMT2

<

Select ‘PORTL tab.

Components e LB

type filter text

A =
SR

-

%

w (= Startup

~ (& Generic
& rbsp

& Drivers

<

~ & Interrupt
@ Config_ICU
~ & /O Ports
« Config_PORT
v = Timers
& Config_CMTO
@ Config_CMT1
@ Config CMT2

Configure

Port selection PORTO PORT1 PORT7 | PORTF |PORT) PORTL

[ Apply to all

Unused GPIO In Qut Pull-up CMOS output
PF5
O Unused GPIO O In Pull-up  |CMOS output
PF6
@ Unused GPIO Olin O out [JPull-up CMOS output
PF7
®Unused GPI0. OIn O out [JPull-up  |CMOS output

Figure 4-29 Select PORTF tab

Configure

Port selection PORTO PORT1 PORT7 PORTF | PORT) JPORTL

[l Apply to all

Unused GPIC In Out Pull-up CEMOS output
P
@®Unused GPIO O'in O 0out [JPull-up  CMOS output
PI3
O Unused GPIO  OIn | @ Out Pull-up | CMOS output
Pi4
@Unused GPIO O'in O Out [JPull-up  CMOS output
PI5
@ Unused GPIO Oln O Out [JPull-up CMOS output
Pl
®unusedGPIO O'in O out [JPull-up  CMOS output
PI7
@®UnusedGPIO Oin OOut [JPull-up  CMOS output

Figure 4-30 Select PORTJ tab
Configure
Port selection PORTO PORT1 PORT7 PORTF PORT) | PORTL

] Apply to all

Unused GPIO In Out Pull-up  [CEMOS output
PLO
OuUnused GPIO O in Pull-up | CMOS output
PL1
@ Unused GPIO Oin O Out [JPull-up  CMOS output

Figure 4-31 Select PORTL tab

Output 1

Normal drive output

Normal drive output

~ Output 1 Normal drive output ~

~ Cutput 1 Normal drive output ~
Output 1

~ Output 1 Normal drive output ~

L Normal drive output ~
~ Cutput 1 Nommal drive output ~
~ Output 1 | Normal drive output ~
hed Qutput 1
~ Output 1

Output 1 Narmal drive output

~ Normal drive output  ~

~ Output 1 Normal drive output ~
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4.6.5 SCI/SCIF Asynchronous Mode

In the RSKRX660, SCI10 is connected via a Renesas RL78/G1C to provide a USB virtual COM port as shown
in the schematic.

Click the ‘Add component’ % icon.

In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’. Select ‘SCI/SCIF Asynchronous Mode’ as
shown in Figure 4-32 then click ‘Next'.

EE Mew Component O X ‘
Software Component Selection tH
Select component from those available in list
Category I Drivers Iv
Function | All ~
Filter '
Components : Short Name Type Version =
& PWM Mode Timer Code Generator 1110
## Real Time Clock Code Generator  17.0
B Remote Control Signal Receiver Code Generator __1.1.0
| £ SCI/SCIF Asynchronous Mode Code Generator  1.11.0 I
B8 SCI/SCIF Clock Synchronous Mode Code Generator  1.11.0
8 Single Scan Mode $12AD Code Generator  24.0
f# Smart Card Interface Mode Code Generator  1.11.0
8 5P| Clock Synchronous Mode (3-wire .. Code Generator 1110
B8 SPI Operation Mode (4-wire method) Code Generator  1.9.0
8 Voltage Detection Circuit Code Generator 1,100
B Watchdog Timer Code Generator 1,100
~

Show only latest version
Hide items that have duplicated functionality

Description

| This software component provides configurations for SCI(SCIF) single{multi-processor)
asynchronous mode,

Download the latest FIT drivers and middieware

Configure general settings...

@ Back I Next > I | Finish | Cancel

Figure 4-32 Select SCI/SCIF Asynchronous Mode

In ‘Add new configuration for selected component’ dialog -> Work mode, select ‘Transmission/Reception’ as
shown in Figure 4-33 below.

ES New Component O X |
Add new configuration for selected component tH
SCI/SCIF Asynchronous Mode

Configuration name: | Config_SCI0

Work mode: |Tta nsmission ™ |

Recires ransmlssmn

| Transmission/Reception
MIUTT-proCesson 1 1ansmission
Multi-processor Reception
Multi-processor Transmission/Reception

Figufe 4-33 Select Work mode — Transmission/Reception
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Ensure that the ‘Configuration name’ is set to ‘Config_SCI10’ as shown in Figure 4-34 below then click ‘Finish’.

E New Component O x ‘
Add new configuration for selected component tL'I
SCI/SCIF Asynchronous Mode
Configuration name: I Config_SCI10 I
Work mode: Transmission/Reception v
Resource: SCo ~
<Back v [ o ] el

Figure 4-34 Ensure Configuration name - Config_SCI10
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Configure SCI10 as shown in Figure 4-35. Ensure the ‘Start bit edge detection’ is set as ‘Falling edge on
RXD10 pin’ and the ‘Bit rate’ is set to 19200 bps. All other settings remain at their defaults.

type filter text

Components faed % B &

~ & Startup
~ & Generic
@ rbsp
~ & Drivers
v & Interrupt
@ Config_ICU
v & 1JO Ports
@ Config_PORT
~ = Communications
« Config_SCI10
~ & Timers
@ Config_CMTO
@ Config_CMT1
@ Config_CMT2

Configure 6]
FIFO mode setting
(@ Non-FIFO mode ) FIFO mode
Start bit edge detection setting
(O Low level on RXD10 pin I (@ Falling edge on RXD10 pin I
Data length setting
O 9 bits @ 8 bits O 7 bits
Parity setting
® None O Even QO 0dd
Stop bit length setting
@1 bit () 2 bits
Transfer direction setting
(@) LSB-first () MSB-first

Data inversion setting
@ Normal O Inverted

Instant transmission setting
[C]Enable instant transmission

Transmitter output setting
(@) Normal O Inverted

Receiver input setting
® Normal O Inverted

Transfer rate setting

Transfer clock Internal clock A

Base clock 16 cycles for 1-bit period b

Bit rate |19200 I v| (bps) (Actual value: 19230.769, Error: 0.16%)
[]Enable modulation duty cormrection

SCK10 pin function SCK10 is not used 3

Transfer timing adjustment setting

] Adjust transmit signal transition Does not change the waveform
[C] Adjust receive data sampling 3 clocks later than default point

Moise filter setting
[ Enable noise filter

Noise filter Clock signal divided by 1 120000000 Hz
Hardware flow contral setting
(@ None QcTs10# (O RTS10#
B . setive trigaer number 15
FIFO data setting
Transmit FIFO data trigger number 0
R FIFO data trigger number 8
Data match detection setting
] Enable data match detection
ita 000
Data handling setting
Transmit data handling Data handled in interrupt service routine v
Receive data handling Data handled in interrupt service routine b
Interrupt setting
TXI10 priority Level 15 {highest) ~
RXI10 priority Level 15 (highest) =
[ Enable reception error interrupt (ERI10)
TEI0, ERIO priarity (Group ALD) Level 15 (highest) v
Receive data ready interrupt Receive data full interrupt (RX1)

Callback function setting
Transmission end Reception end Reception error

Figure 4-35 Config_SCI10 setting
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4.6.6 SPI Clock Synchronous Mode

In the RSKRX660, SCI6 is used as an SPI master for the Pmod LCD on the PMOD1 connector as shown in

the schematic. Click the ‘Add component’ & icon.
In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’. Select ‘SPI Clock Synchronous Mode’ as
shown in Figure 4-36 then click ‘Next'.

ES New Component O * ‘
Software Component Selection tB
Select component from those available in list
CategoryIDrivers I A
Function | All ~
Filter .
Components . Short Name Type Version
B PWM Mode Timer Code Generator  1.11.0
8 Real Time Clock Code Generator  1.7.0
## Remote Control Signal Receiver Code Generator  1.1.0
B SCI/SCIF Asynchronous Mode Code Generator  1.11.0
B8 SCI/SCIF Clock Synchronous Made Code Generator  1.11.0
i Single Scan Mode $12AD Code Generator  24.0
## Smart Card Interface Mode Code Generator  1.11.0
|_i sPi Clock Synchronous Mode (3-wire . Code Generator 1110 |
8 SPI Operation Mode (4-wire method) Code Generator  1.9.0
B Voltage Detection Circuit Code Generator 1,100
# Watchdog Timer Code Generator 1,100
~
Show only latest version
Hide items that have duplicated functionality
Description
| This component provides clock synchronous operation of RSPI or SCI (Simple SPI bus). It |
includes 4 transfer modes: Slave transmit/receive, Slave transmit, Master transmit/receive and
Master transmit. |
Download the latest FIT drivers and middieware
Configure general settings...
2 Back I Next > | | Finish | Cancel

Figure 4-36 Select SPI Clock Synchronous Mode

In ‘Add new configuration for selected component’ dialog -> Operation, select ‘Master transmit only’ as shown
in Figure 4-37 below.

ES Hew Component m} X ‘

Add new configuration for selected component tB

5PI Clock Synchronous Mode (3-wire method)
Configuration name: | Config_RSPIO

Operation: Slave transmit/receive

Slave transmit/receive
Slave transmit only

Resource:

@ < Back Next > Cancel
Figure 4-37 Select Operation — Master Transmit
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In ‘Resource’, select ‘SCI6’ as shown in Figure 4-38 below.

F& New Component O x ‘

Add new configuration for selected component 't{:f

5PI Clock Synchronous Mode (3-wire method)

Configuration name: E;lf-ig_RSl}IEI

Operation: Master transmit only ~

Resource: RSPIO ~
RSPIO

SCI0

scn

sci2

sci3

SCH

|

sCi7
sCi8
sCI9
SCIo
SCin
2 SCl12

Figure 4-38 Select Resource — SCI6

E& New Component O >

Add new configuration for selected component tH’

SPI Clock Synchronous Mode (3-wire method)

Configuration name: ICan ig_SCI6 I
Operation: Master transmit only e
Resource: sCi6 ~

@ < Back Next > Cancel

Figure 4-39 Ensure Configuration name - Config_SCI6

Ensure that the ‘Configuration name’ is set to ‘Config_SCI6’ as shown in Figure 4-39 below then click ‘Finish’
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Configure SCI6 as shown in Figure 4-40. Ensure the ‘Transfer direction’ is set as ‘MSB-first’ and the ‘Bit rate’
is set to 15000 kbps. All other settings remain at their defaults.

Components g ed % 5 B 3 + Configure
e Transfer direction setting
[type filter text | Ouse-firt ® MSB-first
~ (= Starup ~ = -
v & GEI'IEHC data INversion se II'Ig
@ 1 bsp (@ Normal O Inverted
w & Drivers Toansd =
ransfer speed setti
~ & Interrupt P 9
@ Config_ICU Transfer clock Intermnal clock (SCK6 pin functions as clock output pin) ~
~ = IfO Ports
- ;. : Bit rate (kbps)  (Actual value: 15000, Error: 0%)
@ Config_PORT
v & Communications [J Enable modulation duty correction
y Confi 1
‘t_ Lo rg_SC ¢ Clock setting
« Config_SCI6
« & Timers [1€nable clock delay [1€Enable clock polarity inversion

& Config_CMTO
« Config_CMT1
& Config_CMT2 Transmit data handling Data handled in interrupt service routine 4

Data handling setting

Interrupt setting

TXI6 priority Lewvel 15 (highest) ~
TEI6 priority (Group BLO) Lewvel 15 (highest) v
Callback function setting

Transmission end

Figure 4-40 Config_SCI6 setting
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4.6.7 Single Scan Mode S12AD
We will be using the S12AD in Single Scan Mode on the ANO0O0O input, which is connected to the RV1
potentiometer output on the RSK. The conversion start trigger will be via the pin connected to SW3. Click the

‘Add component’ % icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’. Select ‘Single
Scan Mode S12AD’ as shown in Figure 4-41 then click ‘Next'.

ES New Component O X ‘

Software Component Selection t}ff

Select component from those available in list

Category |Drivers | ~
Function All »
Filter .
Components - Short Name Type Version *
B PWM Mode Timer Code Generator  1.11.0
# Real Time Clock Code Gererator  1.7.0
## Remote Control Signal Receiver Code Generator 110
B SCI/SCIF Asynchronous Mode Code Generator  1.11.0
B SCI/SCIF Clock Synchronous Made Code Generator  1.11.0
L: Single Scan Mode S12AD Code Generator 240 I
Smart Card Interface Mode Code Generator 1.11.0
8 SPI Clock Synchronous Mode (3-wire ... Code Generator 1.11.0
i SPI Operation Mode (4-wire method) Code Generator  1.9.0
B Violtage Detection Circuit Code Generator 1,100
B Watchdog Timer Code Generator 1,100

Show only latest version
Hide items that have duplicated functionality

Description

| This software component provides single scan mode configurations for 12-Bit A/D Converter
which the analog inputs arbitranily selected are converted for only once in ascending channel
order.

Download the latest FIT drivers and middleware

Configure general settings...

@ Back I Next > I | Finish | Cancel

Figure 4-41 Select Single Scan Mode S12AD

Ensure that the 'Configuration name' is'Config_S12AD0' as shown in Figure 4-42 below then click ‘Finish’.

G Mew Component O X ‘

Add new configuration for selected component t}:r

Single Scan Mode 512AD

Configuration name: tonfig_S'lEADD

Resource: S12AD0 ™

Figure 4-42 Ensure Configuration name - S12AD0
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Configure S12ADO0 as shown in Figure 4-43 and Figure 4-44 and Figure 4-45. Ensure the ‘Analog input
channel’ tick box for ANOOO is checked and the ‘Start trigger source’ is set to ‘A/D conversion start trigger pin’.
All other settings remain at their defaults.

Components g ed % 5 5 3 ~  Configure

=
: ~ Basic setting
| type filter text |
= - Analog input mode setting
w = Startup -~

[JDouble trigger mode
~ & Generic
& rbsp Analog input channel setting
« = Drivers Evooo [ anoo1 [ amoo2 [ Ano03 [ AnoD4
v & Interrupt [J Ano0OS [] anooe [ amoo7 [ Amoos [ amoo9
« Config_ICU [Janoto [ AND11 [ ano12 (] ano13 (] ANO14
v & A/D Corverter [JAND15 ] AND16 [ anD17 [ anoia [ ANo19
i ol S SR [JAN020 [ ANo21 [J ANO22 [ AN023
w10 Pcrt_s [C] Temperature sensor output [] Intemnal reference voltage
@ Config_PORT
~ = Communications Conversion start trigger setting
: EZ:Z?E:;O Start trigger source IA,.’D conversion start trigger pin I e
v & Timers Interrupt setting

@ Config_CMTO
& Config_CMT1
@ Config_ CMT2

[+#] Enable AD conversion end interrupt (S12ADI)  Priority | Level 15 (highest) ~

= Advance setting
Add/Average AD value setting
[ aNooo ANDO1 ANDD2

Reference voltage setting

@ AVCCO/AVSSO () VREFHO/VREFLD

Self diagnosis setting

Mode Unused hd

Disconnection detection assist setting
Charge setting Unused “

15 ADCLK

Figure 4-43 Config_S12ADO0 setting (1)
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Components g ed % B

type filter text

~

w & Startup

& Generic
@ rbsp

v & Drivers

& Interrupt
@ Config_ICU
& A/D Converter
« Config §12AD0
& 1/O Ports
& Config_PORT
& Communications
& Config_SCI10
@ Config_SCI6
& Timers
@ Config_CMTO
& Config_CMT1
& Config CMT2

Data registers setting

Data placement

Automatic clearing
Addition/Average mode select
Addition count

Window function setting

(® Disable

Window A/B operation setting
[ Enable comparison window A

fow A/B complex

A/D comparison A setting

lata 0 for ¢

e data 1 for comparisor

Use comparator for ANOOO
Use comparator for ANOO1
Use comparator for ANOOZ2
Use comparator for ANOO3
Use comparator for ANOO
Use comparator for ANDOOS
Use comparator for ANDOG
Use comparator for ANOOT
Use comparator for ANDOS
Use comparator for ANOOS
Use comparator for AND10
Use comparator for ANO11
Use comparator for ANO12
Use comparator for AN0O13
Use comparator for ANO14
Use comparator for ANO15
Use comparator for ANO16
Use comparator for ANO17
Use comparator for ANO18
Use comparator for ANO19
Use comparator for AN0O20
Use comparator for AN021
Use comparator for AN022

Use comparator for AND23

|Right-alignment v
| Disable automatic clearing v

:Addlﬁon mode ~

(O Enable

[JEnable comparison window B

Window A companson condition matched OR window B companson condition matched

1]

o

Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 » A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 » A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value

Reference data 0 > A/D-converted value

Use comparator for Temperature sensor output Reference data 0 > A/D-converted value

Use comparator for Intemal reference voltage Reference data 0 > A/D-converted value

Figure 4-44 Config_S12AD0 setting (2)
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Components a3 |2 E B8 B ~ A/D comparnison B setting
T I lata ] 0
type filter text Reference data 1 for comparisor 0
v & Startup ~ mparison B char Unused
v = Generic
A Reference data 0 > A/D-converted value
& rbsp
v & Drivers Input sampling time setting
v & Interrupt ANOOO/Self-di : 045 (us) (Actual value: 0.450)
& Config_ICU elf-diagnosis 0. s \ctual value: 0.450)
v = AfD Comnwerter AN 045 il va
@ Config_S12AD0 \NOO 045 ; A il va
v & I/O Ports c
. W} 045 il va
@ Config_PORT
v (& Communications ) 045 3 \ctual va
@ Config_SCI10 X 045 i
@ Config_SCl6
¢ I 045 3l va
v & Timers
@ Config CMTO N 045 3 Actual va
& Config_CMT1 : s :
@ Config CMT2
045
I 045 il va
P 045 i
I 045 al va
I 045 3l va
I 045 il va
I 045 i
I 045 i
I 3 3
I 4 ]
(Total conversion time: 1.05ps)
ADSTO output setting
[[] Enable ADSTO pin output
Event link control setting
ELC scan end event generation condition On completion of all scans ~
Interrupt setting
Enable AD conversion compare intemupt A (S12CMPAI) = AD conversion compare interrupt B (S12CMPBI)
El t Level 15 (highest

Figure 4-45 Config_S12AD0 setting (3)
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4.7

The ‘Pins’ tabbed page

Smart Configurator assigns pins to the software components that are added to the project. Assignment of the
pins can be changed at Pins page.

4.71

Pin configuration

Hardware Resource

T B

‘ig o,
+ 2 bk

2 Al
% Digital power supply
& Clock

. Clock frequency accuracy measurement circuit

# Operating mode control
2% System control
W On-chip emulator
o2 Buses
W Interrupt
v (@l Multi-function timer pulse unit 3
= MTUD
w MTU1
w MTUZ2
= MTU3
w MTL4
w MTUS
w MTUB
w MTUT
w MTUSB
4, Port output enable 3
~ & 8-bit timer
= TMROD

Pin Function Pin Number

Overview Board |Clocks | System Componentsnterrup'rs
Figure 4-46 The ‘Pins’ tabbed page

Change pin assignment of a software component

To change the pin assignment of a software component in Pin Function list. Click 5% to change view to show

by Software Components.

Pin configuration
Hardware Resource

Type filter text

Figure 4-47 Change view to show by Software Components
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Select the Config_ICU of software component. In the Pin Function list -> Assignment column, change the pin
assignment IRQ9 to P91, IRQ10 to P92. Ensure the ‘Enable’ tick box of IRQ9 and IRQ10 are checked, as
shown in Figure 4-48.

Software Components ER=PLY u%, Pin Function 3 B' .‘1.} | 22 25
Type filter text |r,'pe filter text (* = any string, ? = any character) | All i
~ Lrbsp Enabl.. Function Assignment Pin Number Direction Remarks

= r_bsp [0 rao # Not assigned # Not assigne None
~ & Compare Match Timer 0 rQt # Mot assigned # Mot assigne None
= Config CMTO [0 raz # Not assigned # Not assigne None
w Config CMT1 ] Ira3 # Not assigned 7 Mot assigne None
w Config_CMT2 O ro4 # Not assigned # Mot assigne None
~ & Irlterlu t Controller 1 IraQs # Not assigned # Not assigne MNone
@ Config_ICU [0 IrQe 7 Not assigned # Mot assigne None
v & Pf”“ O Ira? # Mot assigned # Mot assigne MNone
@ Config_PORT [0 Iras8 #_Not assigned # Not assigne None
v & SCI/SCIF Asynchronous Mode IRQ9 |7 _Pa1/TRDATA4/A17/SCK7/IRQI | # 129 I
@ Config_SCI10 IRQ10 7 P92/TRDATAS/A18/POE4#/RXDT/SMISOT} # 128 I
~ L SPI Clock Synchronous Mode (3-wire method) 0 mwran # Not assigned # Not assigne None
@ Config_SCI6 O ra12 7 Mot assigned # Not assigne None
v & Si_ngle Scan Mode S12AD O IRai3 7 Not assigned # Not assigne None
@ Config S12AD0 O IrRQ4 # Not assigned # Not assigne None
[0 IrQ15 # Not assigned # Not assigne None
0 nmi 7 Mot assigned # Not assigne Mone
< »
Pin Function Pin Number

Figure 4-48 Configure pin assignment - Config_ICU

Select the Config_SCI10 of software component. In the Pin Function list -> Assignment column, Ensure the
‘Enable’ tick box of RXD10 and TXD10 are checked and Assignment column of RXD10 is P86 and TXD10 is
P87 as shown in Figure 4-49.

Software Components # = 1% & Pin Function A H| R o
Type filter text |rype filter text (* = any string, ? = any character) | All v
~ &% rbsp Enabl.. Function Assignment Pin Number Direction Remarks

= r_bsp O crsio# 7 Not assigned # Not assigne None
v &L Compare Match Timer O RTsi0# # Not assigned # Mot assigne None
= Config CMT0 RXD10 |7 P86/MTIOCAD/SMISO10/SSCLIO/RXD10/H # 41 [
w Config CMT1 [0 sckio # Not assigned # Mot assigne None
& Contl V12 TXD10 [ P87/MTIOCAC/SMOSI10/SSDAT0/TXD10/] # 39 )
~ & Interrupt Controller
@ Config_ICU
~ & Ports
& Config_PORT
» & SCI/SCIF Asynchronous Mode
& Config_SCI10
v a2 SPI Clock Synchronous Maode (3-wire method)
@ Config_SCI6
v % Single Scan Mode S12AD
@ Config_S12AD0
< >
Pin Function Pin Number

Figure 4-49 Configure pin assignment - Config_SCI10

R20UT5020EG0100 Rev.1.00 RENESAS Page 38 of 71
Jan.17.2022



Renesas Starter Kit for RX660 4. Smart Configurator Using the CS+

Select the Config_SCI6 of software component. In the Pin Function list -> Assignment column, Ensure the
‘Enable’ tick box of SCK6 and SMOSI6 are checked and Assignment column of SCK6 is P02, SMOSI6 is P00
as shown in Figure 4-50.

Software Components # 5 % a8 Pin Function A RS
Type filter text |type filter text (* = any string, ? = any character) All »
v & rbsp Enabl.. Function ignment PinNumber  Direction Remarks

= rbsp SCK6 # P0O2/TMCI1/SCK6/IRQ10 ’ 6 0
~ & Compare Match Timer ™ SMISO6

» Mot assigned 7 Not assigne None
w Config CMT1 SSh# FIoT assigned 7 Not assigne None
w Config_CMT2
v J% Interrupt Controller
@ Config_ICU
~ & Ports
@ Config_PORT
w g5 SCI/SCIF Asynchronous Mode

& Config_SCI10

~ % SP| Clock Synchronous Mode (3-wire method,
I @ Config_SCI& I

- Slnﬁ Scan Mode 512AD
@ Config S12AD0

Pin Function Pin Number

Figure 4-50 Configure pin assignment - Config_SCI6

Select the Config_S12AD0 of software components. In the Pin Function list -> Assignment column, Ensure the
‘Enable’ tick box of ADTRGO# and ANOOO are checked and Assignment column of ANOOO is P40, ADTRGO# is
P07 as shown in Figure 4-51.

Software Components % = 1% & Pin Function DH R o
Type h!:f-- text | _{;.rzf'- filter text (* = any string, 1= any »h.w:m-':r-j. | All v
|v & rbsp Enabl.. Function Assignment Pin Number Direction Remarks
= rbsp [] ADSTO Sl 7 Not assigne None
v M Compare Match Timer ADTRGO# 2 POT/ARQIS/ADTRGO® v 144 |
w Config_CMTO ANOOD # P40/IRQ8/ANDOD 4 !
= Config CMT1 ] ANOO1 # Not assigned ¢ Not assigne None
= Config_CMT2 1 AN0O2 # Not assigned # Not assigne None
~ & Interrupt Controller [0 AN003 # Not assigned # Not assigne None
@ Config_ICU [0 AN004 # Not assigned # Mot assigne None
v & Ports ] ANOOS # Mot assigned # Not assigne None
& Config PORT [] AN0OE r Not assigned # Not assigne None
~ & SCI/SCIF Asynchronous Mode 0 ANOO7 # Not assigned # Not assigne None
@ Config SCI10 [ AnNco8 # Not assigned r Not assigne None
v 4% SPI Clock Synchronous Mode (3-wire method) 0 ANO09 # Not assigned # Not assigne None
@ Config_SCI6 [ ano10 # Not assigned * Not assigne None
L Single Scap hiode S12AD [0 anO11 * Not assigned 7 Not assigne None
I & Config_512AD0 I [J an012 # Not assigned # Not assigne None
[0 an013 * Not assigned 7 Not assigne None
[0 An0D4 # Not assigned # Not assigne None
[0 AnO015 # Not assigned # Not assigne None
[0 AND16 # Not assigned # Not assigne None
[0 An017 # Not assigned 7 Not assigne None
[0 ANDO18 # Not assigned # Mot assigne None
[0 ANO19 # Not assigned 7 Not assigne None
[0 AN020 # Not assigned # Mot assigne None
[0 An021 # Not assigned # Not assigne None
[0 ANg22 # Not assigned # Not assigne None
[ AnN023 # Not assigned * Not assigne None
[0 VREFHO # Not assigned # Not assigne None
[1 VREFLO # Not assigned # Not assigne None
< >
Pin Function Pin Number

Figure 4-51 Configure pin assignment - Config_S12AD0

Peripheral function configuration is now complete. Save the project using the File -> Save, then click
‘©lGenerate Code’ at location of Figure 4-52.

B 5C_Tutorial.scfg 52 =
g

Pin configuration

Figure 4-52 Generate Code Button
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If the Section Setting Dialog is displayed as shown in the Figure 4-53, Please check the box and click “Yes”.

E Section Setting X

i The current project’s section settings (Build tool — Link option — Section settings) are not
compatible with newly generated codes, it is recommended to update the section settings.

Current section settings:

B_1,R_1,B_2,R_2,B,R.5U.5I/4 PResetPRG/FFFO0000,C_1,C_2,C.CSDSEC.CIBSEC.CSINITCSVTBL.C
$VECTD_1,D_2,D,PPIntPRGW_1,W_2 W L/FFFO0100,EXCEPTVECT/FFFFFF80,RESETVECT/FFFFF
FFC

New section settings:

FFFFFFB0,RESETVECT/OxFFFFFFFC
[Yes] to change section settings and generate code
[No] to keep current section settings and generate code
[Cancel] to cancel code generation
Do not show again

Yes No Cancel

Figure 4-53 Section Setting Dialog

The Console pane should report ‘Code generation is successful’, as shown Figure 4-54 below.
After execution, close Smart Configurator and return to CS +.

2 Console x ¥ MO~ v=0
Smart Configurator Output

Me40000@1: File generated:src\smc gen\general
Me4000@@1: File generated:src)\smc gen\general
Mo49eoee1: File generated:srchsmc gen\general
Mo4000001: File generated:srcsmc gen\general\r cg cmt.h

MB400BRR1: File generated:src'smc gen\general\r cg icu.h

Mo4Peoeo1: File generated:srch\smc gen\general\r cg port.h

Mo4000001: File generated:src\smc gen\general\r cg si2ad.h

MB4000eR1: File generated:src'smc gen\general\r cg sci.h

MO5000012: File generated:srch\smc gen\r pincfg\Pin.h

MO5000012: File generated:src\smc gen\r pincfg\Pin.c

MO6POBeR2: File generated:src)smc gen\general\r smc interrupt.c

MOGOOOeR2: File generated:src\smc gen\general\r smc interrupt.h

Me6000e02: File generated:src\smc gen\r config\r bsp interrupt config.h
MB3000004: File modified:src\smc gen\r config\r bsp config.h

Moeeeoee2: Code generation is successful:C:\Workspace\SC Tutoriallsrc\smc gen

cg userdefine.h A
smc_entry.h
cg hardware setup.c

Figure 4-54 Smart Configurator console

When code generation is executed, the startup files generated at the time of CS+ project creation are
replaced with those generated by Smart Configurator. Figure 4-55 the project tree after code generation. In
the next chapter, user code is added to these files, and SC_Tutorial is completed by adding a new source file

to the project.

Project Tree X
¢ @ 8 &
BLﬁ SC Tutorial (Project)*
R5F56609HxFB (Microcentroller)
smart Configurator (Design Tool)
CC-RX (Build Toel)
2 XY Simulator (Debug Tool)

' Program Analyzer (Analyze Tool)
=-[J File
; fﬂ Build tool generated files
: J SC_Tutorial.c

@[E Smart Configurator
[]---I_-ﬂ general
-l rbsp

-1 r_config

e Ll r_pincfg
||l Config_CMTo
f-| || Config_CMT1
||| Config_CMT2
[E
[E
[E
[E
[E

0. || Config_icu
o[l Config_PORT
9| Config_S12AD0
9|} Config_sCi1o
5[]} Config_sCla

Figure 4-55 Smart Configurator folder structure
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5. Completing the Tutorial Project

5.1 Project Settings

e In the ‘Project Tree' pane, select
‘CC-RX (Build Tool)y. The build
properties will appear in the main
window.

il Project Tree 2 x

¢ @ 2|

=-|f§ SC Tutorial (Project)*

..... i& R5F56609HxFE (Microcontroller)
..... D:‘I Smart Configurator [Design Tool)
----- % CC-RX (Build Tool)

..... g, RX Simulator (Debug Tool)

..... ’::' Program Analyzer (Analyze Tool)

-3 File

e C(CS+ creates a single build
configuration called ‘Default Build’ for
the project. This has standard code
optimisation turned on by default.

4. CC-RX Property

~ Build Mode
Build mode
Change property value for 2ll build modes at once No
v CPU
Instruction set architecture RXwv3 architecture(4za=nwv 3)
Uses single-precision floating-point operation instructions Yes(fpu)

Uses double-precision floating-point operation instructions Mo

Endizn type for data Little-endian datal-endian=litle)

Rounding methoed for floating-point constant operations round to nearest(-ound=nearest)

Handling of denormalized numbers in floating-point constants Handles as zeros(-denomalize=off)
Precision of the double type and long double type Handles in single precision|-dbl_size=4)
Replaces the int type with the short type Mo

Sign of the char type Handles as unsigned charl-unsigned_char)
Sign of the bit-field type Handles as unsigned(-unsigned_bitfield)
Selects the enumersation type size automatically No

Order of bit-field members Allocates from right{bit_order=rght)

e Select the ‘Compile Options’ tab at
the bottom of the properties window
pane. Under ‘Language of the C
source file’ select ‘C99(-lang=c99)’
as shown opposite.

A, CC-RX Property

v Source
Language of the C source file |C99(Hang=c99) |
Language of the C++ source file CeHang=cop)

Additional include paths[17]

System include paths[0]

Include files at the head of compiling units[0]
Macno definition[0]

» Additionzl include paths
> Systeminclude paths
> Include files at the head of compiling units
> Macro definition
Imvalidates the predefined macro

Enables information-level message output MNol-nomessage)
Suppresses the number of information-level messages

Undisplayed messages

Changes the warning-level m to informati vel m Mo

Changes the information-level m to warning-level m Mo

Language of the C source file
Selects language of the C source file.
This corresponds to the -lang option of the compiler.

Common Options _}I Compile Options I\ AzzembleOptions ,( Link Options ,( Hex Output Options ,( Library Generate ©

e Select the ‘Link Options’ tab at the
bottom of the properties window
pane. Under ‘Section -> ROM to
RAM mapped section’, add the three
mappings as shown opposite.

~ Section
Section start address

> The specified section that cutputs externally defined symbols to the file

5 Section alignment Section alignment[0]

> FOM to RAM mapped section(3] D

> Verify

> Others

SU.SI.B_1.R_1.B_2.R_2.B.R/4.C_1.C_2.C.C$".D".W".L.P*/FFF0000.EXCEPTVEC
“The specilied section that outputs extemaly defined symbols to the fikl0]

ROM to RAM mapped secion
Specifies ROM to RAM mapped section in the format of "<ROM section name>=<RAM section name=". one per line.
This corresponds to the -rom option of the linker.

Common Options / CompileOptions | AssembleOptions |, Link Options § Hex Output Options /  Library Generate Options
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These settings are easily added by
clicking the button ‘..." and pasting
the following text into the dialog:

D=R
D_1=R_1
D 2=R 2

This ensures that the linker assigns
RAM rather than ROM addresses to
C variables. Click ‘OK’

Text Edit

*

Cancel Help

From the ‘Build’ menu, select ‘Build
Mode Settings.... Click ‘Duplicate’

€3 SC_Tutorial - CS+ for CC - [Property]

File Edit View Project |Build | Debug Tool IWindowIHeIp

. . ‘ .
and in the resulting ‘Character String @ st | (@ [ @ @ Buid Project =
PR ‘ ’ :
Input’ dialog, en_ter Depug for the S g & g | T Rebuid Prjec e
name of the duplicate Build Mode. %—Q Clean Proi
ﬂ_' Project Tree ean Project
2 s @ 3|[@ Rapid Build |
% Bq_ﬁ SC Tutorial (P % Update Dependencies
Z : &l Build SC_Tutorial
Rebuild SC_Tutorial
Clean SC_Tutorial
Update Dependencies of SC_Tutorial
Set Link Order of SC_Tutorial...
Open the Optimization Performance Comparisen Tool for SC_Tutorial...
Stop Build Ctrl+F7
Build Mode Settings...
Tl Batch Build...
Brpf J
|_E Cor Ti Build Option List
Build Mode Settings *
Selected build mode:
[ |
Build mode list:
Character String Input X
String
Pebug
Help Corca Help
The new ‘Debug’ Build Mode will be | |* cchxFrores
e Dfut Buid

added to the Build Mode list. Click
‘Close’. Now, in the main CC-RX
Property  window, under the
‘Common Options’ tab, click on the
line containing ‘Build Mode’, click the
pull-down arrow and select ‘Debug’
from the pull-down’.

Change property value for all build modes at once
~ CPU

Instruction set architecture

Uses single-precision floating-point operation instructions

Uses double-precision floating-point operation instructions

Endian type for data

Rounding methed for floating-point constant operations

Handling of denormalized numbers in floating-point constants

Precision of the double type and long double type

Replaces the int type with the short type

Sign of the char type

Sign of the bit-field type

Selects the enumeration type size automatically

Order of bit-field members

Assumes the boundary alignment value for structure members is 1

Enables C++ exceptional handling function (try, catch and throw)

Enables the C++ exceptional handling function (dynamic_cast and typeid)
Build mode
Selects the build mede name to be used during build.

Yes(fpu)
No
Little-endian data(-endian=little)

round to nearest{-round=nearest)
Handles as zeros(-denomalize=off)
Handles in single precision(-dbl_size=4)
No

Handles as unsigned char(-unsigned_char)
Handles as unsigned(-unsigned_bitfield)
No

Allocates from right(bit_order=right)
Nof-unpacic)

Molnoexception)

MNoftti=off)

| Common Options IA Compile Options 1 AssembleOptions

L Link Options A

Hex Output Options A Library Generate Options J
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e In the ‘Frequently Used Options (for | |* ccxieey 4l b2 =
Compile)’  group, select  the Buld mod Debug
‘ . . . y . Change property value for all builld modes &t once No
Optimization Level’ option and select cPU
‘0’ from the pull-down. We have NOW | |2 femrie rypemdran
created a ‘Debug’ Build Mode with ettt e oot ol St
1 1 1 1 + Frequently Used Options(for Compile)
no_ COde OpFImlsatlon and WI” be Ad:i‘:iqnal inyc\udepaths Additional include paths[17]
using the Build Mode to create and System include paths System include paths[0]
. Macro definition Macra definition[0]
debug the prOJeCt Outputs debugging information Yes(-debug)
Optimization level 2{-optimize=2)
DtpuL‘s additional information for inter-module optimization e :
Optimization type
Outputs 3 source list file
v Fi Hy Used Oy Mazx(-optimize=max)
e Al of the sample code projects | |* cxreey 2l Bl =
contained in this RSK are configured Build mode Relcase
. . Change property value for all build modes &t once No
with three Build Modes; cPu
‘DefaultBuild’, ‘Debug’ and ‘Release’. | | bumrietysemira
‘ ' g H Output file Execute Module(Load Module File)
Release IS Created In the same Way Int;r?rr‘ted\ag:?eoutputfolder 3‘;BUI|l;tMOdeNaIT:e’-=
. i H ‘ ~ Frequently Used Opons(for Compile)
as a,boye’ by ,dupllcatlng DefaU|t Qd:i‘:ienalinyc\udepaths Additional include paths[17]
Build’. ‘Release’ Build Mode leaves System ncluce paihs S e o
code Optimisation turned on and Outputs debugging information Yes(debug)
. . Optimization level 2{-optimize=2)
removes debug information from the | | ol ser iemionterinermosue cpriza o _
Output f'le. gﬂpr:za:z:::::“stﬁle ﬁ:t,'r.‘n;;;‘\:';h emphasis on code size(-size)
X i F ly Used O
e To remove debug information from | |~ Froquontiy Used Ogons(hr i) S
the ‘Release’ Build Mode, in the ‘CC- vesfomutsmheompmf.\e;_..usa@
RX  Property’ window, select the St it thees Yo et o e e ek Db
‘Common Options’ tab at the bottom | | Freauently UsedOptnsiio Hex Ot IR
of the window pane. For the
‘Outputs  debugging information’
option, select ‘No(-nodebug).
e Reset the Build Mode back to
‘Debug’ using the ‘Build Mode’ pull-
down control.
e From the menus, select ‘File -> Save

All' to save all project settings.
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5.2 Additional Folders

e Before new source files are added to
the project, we will create two
additional folders in the CS+ Project
Tree.

e In the Project Tree pane, right-click
the SC_Tutorial project and select
‘Add -> Add New Category’.

Project Tree

o o e

i J% RofoooooHarE &) Build SC_Tutorial
Smart Cenfigu E Rebuild SC_Tutorial
A, CC-RX (Build T)
& RX Simulator (
(@ Program Analy Open Folder with Explorer

E"ﬂ File B Windows Explorer Menu

B Clean SC_Tutorial

Build tool

SCTutorid] __Add g

BEEI Smart Conf "fg
: i
|:|1. general
Orbsp |1

Set 5C_Tutorial as Active Project

Save Project and Development Tools as Package...

Add Subproject...

+ Proj

It Add Mew Subproject...
+ Proj

[} AddFile..

¥ Add New File...

Eﬂ r_confi{ (f§| Paste Cirl+V
l:lll r-pincf @ Rename F2
-] config]

Eﬂl Config| @ Property

Eﬂ Add New Category

o Rename the newly-created ‘New
Category’ folder to ‘C Source Files’.
Repeat these steps to create a new
category folder for ‘Dependencies’.

Project Tree

; @ 323

=L f} SC Tutorial {Project}*
... 3% R5FSEE0SHXFE (Microcontroller)
Smart Cenfigurator (Design Tool)
4, CC-RX (Build Tool)
éa RX Simulator (Debug Tool)
(@ Program Analyzer (Analyze Tool)
&- [ File
ﬂ Build tool generated files
..&2| SC Tutorial.c

I:I!l Smart Configurator
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5.3 LCD Code Integration

API functions for the Okaya LCD display are provided with the RSK. Refer to the Tutorial project folder
created according to the Quick Start Guide procedure. Check that the following files are in the src folder:
-ascii.c
-ascii.h
r_okaya_lcd.c
r_okaya_lcd.h

Copy these files in to the src folder below the workspace and then follow the steps below.

» Move the ‘SC_Tutorial.c’ file from B E R - scCTuoial
‘C:\Workspace\SC_Tutorial’ to Al ome | Share  View
‘C'\Workspace\SC Tutorial\srcl &« v 4 » ThisPC » Local Disk (C:) » Workspace » SC_Tutorial
a MName ) - Daten
7 Quick access R
Debug
& This PC DefaultBuild
[ Desktop Release ik
- >
|| Documents “
‘ Downloads J dbsct.c
J’ Music jhwsetup.c
o jintprg.c
= Pfctures jiodeﬁne.h
B videos |:| lowlvl.src
o Local Disk (C:) “owsre.c
& Network j lowsrc.h
jresetprg.c
jsbrk.c
1 shrk.h
[ sC_Tutorial. %833, mtud
@) sC_Tutorial.mtpj
« Select SC_Tutorial.c on the project tree, Right- - b g
H ' . ' ] =]
click and select 'Remove from Project' to 2 ? ERE]
. . -|_T4 SC Tutorial (Project)*
exclude it from the project. B s ——

R5F56609HXFB (Microcontroller)
| Smart Configurator (Design Tool)
CC-RX (Build Tool)

2! RX Simulator (Debug Tool)

’J Program Analyzer (Analyze Tool)
[ File

ﬂ Build tool generated files

R3] rutorg

-]l Smart Conf @ Compile
Open

Open with Internal Editor...

Open with Selected Application...

Open Folder with Explorer

Windows Explorer Menu

Add 2

|@ Remove from Project Shift+Del

» Right-click on the ‘C Source Files’ folder and é"—ri!'i'ﬂeslm&nﬁ o H
select ‘Add’ -> ‘Add File...". -

.. Dependencig  Add Y| 1 AddFile.. |
BL| Open Folder with Explorer Add Mew File...
5 Windows Explorer Menu i:_-:j:l, Add New Category
Remove from Project Shift+Del
i3 Copy Ctrl+C
4| Paste Ctrl+V
Rename F2
Property
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« Select the files to be added (ascii.c,
r_okaya_lcd.c, SC_Tutorial) from C:
\Workspace\SC_Tutorial\src.

™ Add Bxisting File

« v A « Workspace » SC_Tutorial » src » ar Search src »
Organize » Mew folder f==~ OH 0
~
Name
3t Quick access
smc_gen
& This PC ascii.c
[ Desktop E r_okaya_lcd.c
Documents E SC_Tutorial.c
¥ Downloads
D Music
&=/ Pictures
B videos
=5 Local Disk (C:)
b Network
< >
File name: | "SC_Tutorial.c” "ascii.c' "r_okaya_lcd.c" \/| C source file (*.c) ~

« Similarly, add ‘ascii.h’ and ‘r_okaya_lcd.h’ to the

@ Add Existing File

screen shot.

'Dependenciesl folder- « v <« Workspace » SC_Tutorial » src » v |0 Search src yel
Organize New folder =~ ™ @
Name -
Note: Select the Header file (* .h; * hpp; * .inc). # Quick access e gen
B This PC ) asciih
[ Desktop | r_okaya_lcd.h
Documents
4 Downloads
B Music
=] Pictures
B videos
o Local Disk (C:)
= Network
€ >
File name: “'rﬁokayailcd.h" “asciih” v| |Headerfile ("h; “.hpp; ~.inc) |
« Make sure the project tree is the same as the Project Tree o X

E[ﬁ SC Tutorial (Project]
. % RSFS6609HxFB (Microcontroller)
----- :::J Smart Configurater (Design Tocl)
..... 4 CC-RX (Build Tool)
----- ze, R Simulator (Debug Tool)
..... ’3‘ Program Analyzer (Analyze Tool)
-3 File

L] smart Configurator

..... (_:J r_okaya_lcd.c
- & SC Tutorial.c
- _E Dependencies

..... ilJ ascil.h

..... | r_okaya_lcd.h

o |
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Code must be inserted in to the user code area in many files in this project, in the areas delimited by
comments as follows:

/* Start user code for xxxxx . Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Where _xxxx_ depends on the particular area of code, i.e. ‘function’ for insertion of user functions and
prototypes, ‘global’ for insertion of user global variable declarations, or ‘include’ for insertion of pre-processor
include directives. User code inserted inside these comment delimiters is protected from being overwritten by
Smart Configurator, if the user subsequently needs to use Smart Configurator to regenerate any of the Smart
Configurator-generated code.

In the CS+ Project Tree, expand the ‘Smart Configurator\general’ folder and open the file ‘r_cg_userdefine.h’
by double-clicking on it. Insert the following #defines in between the user code delimiter comments as shown
below.

/* Start user code for macro define. Do not edit comment generated here */

#define TRUE (1)
#define FALSE (0)

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area for include near the top of the file:
/* Start user code for include. Do not edit comment generated here */
#include "platform.h"

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the type define.
/* Start user code for type define. Do not edit comment generated here */
typedef char char t;

/* End user code. Do not edit comment generated here */

In the CS+ Project Tree, expand the ‘C Source Files’ folder and open the file ‘SC_Tutorial.c’ by double-clicking
on it. Add header files above the ‘main’ function as shown below.

#include "r okaya
finclude "r cg userde

Scroll down to the ‘main’ function and insert the highlighted code as shown below into the beginning of the
‘main’ function:

void main (void)

{
/* Initialize the debug LCD */
R_LCD Init();

/* Displays the application name on the debug LCD */
R _LCD Display (0, (uint8 t *)" RSKRX660 ");

R _LCD Display(l, (uint8 t *)" Tutorial ");

R_LCD Display(2, (uint8 t *)" Press Any Switch ");
while (10)

{

}

Indentation is lost when the code described in this manual is pasted into the CS+ source file. Also check that the
pasted code is correct.
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5.31 SPICode

The Okaya LCD display is driven by the SPI Master that was configured using Smart Configurator in section
4.6.6. In the CS+ Project Tree, expand the ‘Smart Configurator/Config_SCI6’ and open the file ‘Config_SCI6.h’
by double-clicking on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Exported functions used to transmit a number of bytes and wait for completion */
MD STATUS R SCI6 SPIMasterTransmit (uint8 t * const tx buf, const uintl6 t tx num);

/* End user code. Do not edit comment generated here */

Now, open the ‘Config_SCI6_user.c’ file and insert the following code in the user area for global:

/* Start user code for global. Do not edit comment generated here */

/* Flag used locally to detect transmission complete */
static volatile uint8 t s_sci6_txdone;

/* End user code. Do not edit comment generated here */

Insert the following code in the transmit end call-back function for SCI6:
static void r Config SCI6 callback transmitend(void)
{
/* Start user code for r Config SCI6 callback transmitend. Do not edit comment generated here */

s _sci6_ txdone = TRUE;

/* End user code. Do not edit comment generated here */

}
Now insert the following function in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

Y e e

* Function Name: R SCI6 SPIMasterTransmit

* Description : This function sends SPI6 data to slave device.
* Arguments ¢ tx buf -

* transfer buffer pointer

* tx num -

* buffer size

* Return Value : status -

* MD OK or MD ARGERROR

************~k‘k‘k‘k~)<~k~k~k~k~k~k~k~k************************~k~k~k************‘k*‘k************/
MD STATUS R_SCI6_SPIMasterTransmit (uint8 t * const tx buf, const uintl6é_t tx num)

{
MD STATUS status = MD OK;

/* Clear the flag before initiating a new transmission */
s sci6 txdone = FALSE;

/* Send the data using the API */
status = R _Config SCI6_SPI Master Send(tx buf, tx num);

/* Wait for the transmit end flag */
while (FALSE == s_sci6_txdone)
{
/* Wait */
}

return (status);

}

KKK KK KKK K K Kk ke ok ok ok ok K K R R K K Kk ks ok ok kR K R KRR R K K Kk R R R R R R R R R K R K K Kk K ko kR ok ok ok ok ok ok

* End of function R SCI6 SPIMasterTransmit

*******************************************************************************/

This function uses the transmit end callback function to perform flow control on the SPI transmission to the
LCD, and is used as the main API call in the LCD code module.
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5.3.2 CMT Code

The LCD code needs to insert delays to meet the timing requirements of the display module. This is achieved
using the dedicated timer which was configured using Smart Configurator in section 4.6.2. In the CS+ Project
Tree, expand the ‘Smart Configurator\Config_ CMTO0\Config CMTO0.h’ and insert the following code in the user
area for function at the end of the file:

/* Start user code for function. Do not edit comment generated here */
void R_CMT MsDelay (const uintl6_t millisec);

/* End user code. Do not edit comment generated here */

Open the file ‘Config_ CMTO_user.c’ and insert the following code in the user area for global at the beginning
of the file:

/* Start user code for global. Do not edit comment generated here */
static volatile uint8 t s one ms delay complete = FALSE;

/* End user code. Do not edit comment generated here */

Scroll down to the r_Config_ CMTO_cmiO_interrupt function and insert the following line in the user code area:

static void r Config CMTO cmiaO interrupt (void)
{
/* Start user code for r Config CMTO cmiO interrupt. Do not edit comment generated here */

s_one ms_delay complete = TRUE;

/* End user code. Do not edit comment generated here */

Then insert the following function in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

VAR AR AR AR EEEE LSSt EEE Rttt AR EEE LR EEE Rty

* Function Name: R CMT MsDelay

* Description : Uses CMTO to wait for a specified number of milliseconds
* Arguments : uintl6 t millisecs, number of milliseconds to wait
* Return Value : None

********k*k**k*k*‘k‘k‘k‘k‘k‘k‘k~k*****************‘k*‘k‘k*‘k‘k*‘k~k‘k‘k‘k‘k‘k‘k‘k‘k‘k****************‘k‘k‘k‘k‘k‘k/
void R _CMT MsDelay(const uintlé_t millisec)
{

uintl6é_t ms_count = 0;

do
{
R Config CMTO Start();
while (FALSE == s_one ms_delay complete)
{
/* Wait */
}
R _Config CMTO_Stop();
s_one_ms_delay complete = FALSE;
ms_count++;
} while (ms_count < millisec);

}

/********************************‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k********************************

End of function R CMT MsDelay

LA AR EEEEE SRR EEEE LSRR EEEE RS ERREEEEEE SRR

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in section 6. The program will display
‘RSKRX660 Tutorial Press Any Switch’ on 3 lines in the LCD display.
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5.4 Switch Code Integration

API functions for user switch control are provided with the RSK. Refer to the Tutorial project folder created
according to the Quick Start Guide procedure. Check that the following files are in the src folder:
-rskrx660def.h
-r_rsk_switch.c
-r_rsk_switch.h

Copy these files in to the src folder below the workspace. Add these files into the project in the same way as
the LCD files as in section 5.3.

The switch code uses interrupt code in the files Config_ICU.c, Config_ICU_user.c and Config_ICU.h and timer
code in the files Config_ICU.c, Config ICU_user.c, Config CMT1.h, Config_ CMT1.c, Config_ CMT1_user.c,
Config_CMT2.h, Config_CMT2.c, and Config_ CMT2_user.c, as described in section 4.6.2 and section 4.6.3.
It is necessary to provide additional user code in these files to implement the switch press/release detection
and de-bouncing required by the API functions in r_rsk_switch.c.

5.4.1 Interrupt Code

In the CS+ Project Tree, expand the ‘Smart Configurator/Config_ICU’ folder and open the file ‘Config_ICU.R’
by double-clicking on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Function prototypes for detecting and setting the edge trigger of ICU IRQ */
uint8 t R ICU IRQIsFallingEdge (const uint8 t irqg no);

void R_ICU IRQSetFallingEdge (const uint8 t irg no, const uint8 t set f edge);
void R_ICU TIRQSetRisingEdge (const uint8_t irqg no, const uint8 t set r edge);

/* End user code. Do not edit comment generated here */
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Now, open the ‘Config_ICU.c’ file and insert the following code in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

[ KKK KA KKK KKK KKKk hh kI AR AR K KKk Kk hh kI A AR AAA A I KKKk khh kI A AAAAAA A I Kk k ok hh kAR AA A X

* Function Name: R ICU_IRQIsFallingEdge

* Description : This function returns 1 if the specified ICU IRQ is set to
* falling edge triggered, otherwise O.
* Arguments : uint8_t irg no

* Return Value : 1 if falling edge triggered, 0 if not
*******************************************************************************/

uint8 t R ICU IRQIsFallingEdge (const uint8 t irqg no)
{
uint8 t falling edge trig = 0x0;
if (ICU.IRQCR[irg no].BYTE & 04 ICU IRQ EDGE_FALLING)

{
falling edge trig = 1;
}

return (falling edge trig);
}

/*******************************************************************************

* End of function R_ICU_IRQIsFallingEdge

********************************************************************k**********/

[ KK KKK K K K K kK kK K R K K K R K K K ok K K R K K R R K K ok K K ok K ok kK K ok K K K ok K K R ok K K R kK R K K R R K K Rk Kk R ok Kk ok kK ok ok

* Function Name: R _ICU IRQSetFallingEdge

* Description : This function sets/clears the falling edge trigger for the

* specified ICU IRQ.

* Arguments : uint8_t irg no

* uint8 t set f edge, 1 if setting falling edge triggered, 0 if

* clearing

* Return Value : None
***************************~k~k~k~k~k~k~k~k~k~k******************************************/

void R_ICU IRQSetFallingEdge (const uint8 t irg no, const uint8 t set f edge)
{
if (1 == set_f edge)
{
ICU.IRQCR[irg no] .BYTE |= 04 ICU IRQ EDGE_ FALLING;
}

else

{
ICU.IRQCR[irg nol] .BYTE &= (uint8 t) ~ 04 ICU IRQ EDGE FALLING;

/******************************************************************************

* End of function R ICU IRQSetFallingEdge

KKK KKK K KK K KK KK K K K K K KK K K R R KK K R R K KK R R R kR R R R R R R R R R R R R R R R R R R R R R Rk Rk R R Rk ok Rk x /

JE KK KA KK KKK KKK Kk I I I A AR KK KKK kI A A A AR A A A A I KKk hhhh kAR AAA A I Ak Ak k ok ki h ok h kA A A XK

* Function Name: R _ICU IRQSetRisingEdge

* Description : This function sets/clear the rising edge trigger for the

* specified ICU IRQ.

* Arguments : uint8 t irg no

* uint8 t set r edge, 1 if setting rising edge triggered, 0 if
* clearing

*

Return Value : None
*******************************************************************************/

void R _ICU IRQSetRisingEdge (const uint8 t irg no, const uint8 t set r edge)
{
if (1 == set_r edge)
{
ICU.IRQCR[irg no] .BYTE |= 08 ICU IRQ EDGE_ RISING;
}

else

{
ICU.IRQCR[irg no] .BYTE &= (uint8 t) ~ 08 ICU IRQ EDGE RISING;

/******************************************************************************

* End of function R ICU IRQSetRisingEdge

*******************;***********************************************************/

/* End user code. Do not edit comment generated here */
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Open the ‘Config_ICU_user.c’ file and insert the following code in the user code area for include near the top
of the file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "r rsk switch.h"

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function
r_Config_ICU_irq1_interrupt:

/* Start user code for r Config ICU irgl interrupt. Do not edit comment generated here */

/* Switch 1 callback handler */
R _SWITCH IsrCallbackl();

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function
r_Config_ICU_irg2_interrupt:

/* Start user code for r Config ICU irg2 interrupt. Do not edit comment generated here */

/* Switch 2 callback handler */
R_SWITCH IsrCallback2();

/* End user code. Do not edit comment generated here */
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5.4.2 De-bounce Timer Code

In the Project Tree, expand the ‘Smart Configurator\Config_ CMT1’ folder and open the ‘Config_ CMT1_user.c’
file and insert the following code in the user code area for include near the top of the file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "r rsk switch.h"

/* End user code. Do not edit comment generated here */

In the ‘Config_ CMT1_user.c’ file insert the following code in the user code area inside the function
r_Config_ CMT1_cmi1_interrupt:

/* Start user code for r Config CMT1 cmil interrupt. Do not edit comment generated here */

/* Stop this timer - we start it again in the de-bounce routines */
R Config CMT1 Stop();

/* Call the de-bounce call back routine */
R_SWITCH_ DebouncelIsrCallback();

/* End user code. Do not edit comment generated here */

In the Project Tree, expand the ‘Smart Configurator\Config_ CMTZ2’ folder and open the ‘Config_ CMT2_user.c’
file and insert the following code in the user code area for include near the top of the file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "r rsk switch.h"

/* End user code. Do not edit comment generated here */

In the same file and insert the following code in the user code area inside the function
r_Config_CMT2_cmi2_interrupt:

/* Start user code for r Config CMT2 cmi2 interrupt. Do not edit comment generated here */

/* Stop this timer - we start it again in the de-bounce routines */
R Config CMT2 Stop();

/* Call the de-bounce call back routine */
R_SWITCH DebouncelIsrCallback();

/* End user code. Do not edit comment generated here */
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5.4.3 Main Switch and ADC Code

In this part of the tutorial we add the code to act on the switch presses to activate A/D conversions and display
the result on the LCD. In section 4.6.7 we configured the ADC to be triggered from the ADTRGO# pin, SW3.
In this code, we also perform software triggered A/D conversion from the user switches SW1 and SW2, by
reconfiguring the ADC trigger source on-the-fly once an SW1 or SW2 press is detected.

In the CS+ Project Tree, expand the ‘Smart Configurator\general’ folder and open the file ‘r_cg_userdefine.h’
by double-clicking on it. Insert the following code the user code area, resulting in the code shown below

/* Start user code for function. Do not edit comment generated here */

extern volatile uint8_t g_adc_trigger;

/* End user code. Do not edit comment generated here */

In the Project Tree, expand the ‘C Source Files’ folder and Open the file ‘SC_Tutorial.c’ and add the
highlighted code, resulting in the code shown below:

#include h"
#include .h"
#include efine.h"
#include "Config S12ADO.h"
#include "r rsk switch.h"

/* Variable for flagging user requested ADC conversion */
volatile uint8 t g adc_trigger = FALSE;

/* Prototype declaration for cb switch press */
static void cb switch press (void);

/* Prototype declaration for get adc */
static uintl6 t get adc(void);

/* Prototype declaration for lcd display adc */
static void lcd display adc (const uintl6 t adc result);
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Next add the highlighted code below in the main function and the code inside the while loop, resulting in the
code shown below:

void main (void)

{
/* Initialize the switch module */
R _SWITCH Tnit();

/* Set the call back function when SWl1l or SW2 is pressed */
R_SWITCH SetPressCallback(cb _switch press);

/* Initialize the debug LCD */
R_LCD Init();

/* Displays the application name on the debug LCD */
R _LCD Display (0, (uint8 t *)" RSKRX660 ");

R _LCD Display(l, (uint8 t *)" Tutorial ");

R_LCD Display (2, (uint8 t *)" Press Any Switch ");

/* Start the A/D converter */
R _Config S12AD0_Start();

while (10U)
{
uintl6é t adc result;

/* Wait for user requested A/D conversion flag to be set (SWl or SW2) */
if (TRUE == g adc_trigger)
{

/* Call the function to perform an A/D conversion */

adc_result = get_adc();

/* Display the result on the LCD */
lcd display adc (adc_result);

/* Reset the flag */
g_adc_trigger = FALSE;
}
/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */
else if (TRUE == g adc complete)
{
/* Get the result of the A/D conversion */
R _Config S12AD0_Get ValueResult (ADCHANNELO, &adc_result);

/* Display the result on the LCD */
lcd display adc(adc_result);

/* Reset the flag */
g_adc_complete = FALSE;
}
else
{
/* do nothing */
}
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Then add the definition for the switch call-back, get_adc and lcd_display_adc functions adding at the below of
the main function, as shown below:

KA A A A A A A A A A A A A A A A A A A A A A A A A A A A A A Ak kkhkkhkhkhkhkhkhkhkhkhkhk hk kA A A A A A A A A A A A A A A A A A AR A A A Ak ko k

* Function Name : cb switch press

* Description : Switch press callback function. Sets g adc trigger flag.
* Argument : none

* Return value : none

******************************************************************************/

static void cb _switch press (void)

{
/* Check if switch 1 or 2 was pressed */
if (g switch flag & (SWITCHPRESS 1 | SWITCHPRESS 2))
{

/* set the flag indicating a user requested A/D conversion is required */
g_adc_trigger = TRUE;

/* Clear flag */
g _switch flag = 0x0;
}
}

VAR AR EEEEEEE RSttt e R EEE e EEEE e

* End of function cb_switch press
******************************************************************************/

[ KKK K K K K K K K K K K K K K K Kk K K ok ok kK K R R R K R K ok ok ok kK R R ok K K R R Rk R R R R R R kR R Rk ok Rk Rk x

Function Name : get adc

* Description : Reads the ADC result, converts it to a string and displays
* it on the LCD panel.

* Argument : none

* Return value : uintl6_t adc value

******************************************************************************/
static uintl6 t get adc (void)

/* A variable to retrieve the adc result */
uintlé_t adc_result;

/* Stop the A/D converter being triggered from the pin ADTRGOn */
R Config S12ADO0 Stop();

/* Start a conversion */
R_S12AD0O_SWTriggerStart();

/* Wait for the A/D conversion to complete */
while (FALSE == g adc_complete)
{
/* Wait */
nop () ;
}

/* Stop conversion */
R _S12AD0_SWTriggerStop () ;

/* Clear ADC flag */
g _adc_complete = FALSE;

R _Config S12AD0 Get ValueResult (ADCHANNELO, &adc_result);

/* Set AD conversion start trigger source back to ADTRGOn pin */
R Config S12AD0_Start();

return (adc_result);

}

/******kk****************kkkk**************************************************

* End of function get adc
******************************************************************************/
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/******************************************************************************

* Function Name : lcd display adc

* Description : Converts adc result to a string and displays
* it on the LCD panel.

* Argument : uintl6_t adc result

* Return value : none

******************************************************************************/
static void lcd display adc (const uintl6é_t adc_result)
{

/* Declare a temporary variable */
char t tmp;

/* Declare temporary character string */
char t lcd buffer[11l] = " ADC: XXXH";

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

tmp = (char t) ((adc_result & 0x0F00) >> 8);

lcd buffer[6] = (tmp < 0x0A) ? (tmp + 0x30) : (tmp + 0x37);
tmp = (char_t) ((adc_result & 0x00F0) >> 4);

lcd buffer[7] = (tmp < 0x0A) ? (tmp + 0x30) : (tmp + 0x37);
tmp = (char t) (adc_result & 0x000F);

lcd buffer([8] = (tmp < 0x0A) 2 (tmp + 0x30) : (tmp + 0x37);

/* Display the contents of the local string lcd buffer */
R_LCD Display(3, (uint8 t *)lcd buffer);

}

VAR R EEEEEEE RS E R R e R E R E R R

* End of function lcd display adc

******************************************************************************/

In the Project Tree, expand the ‘Smart Configurator\Config_S12AD0’ folder and open the file
‘Config_S12ADO0.h’ by double-clicking on it. Insert the following code in the user code area for function,
resulting in the code shown below:

/* Start user code for function. Do not edit comment generated here */

/* Flag indicates when A/D conversion is complete */
extern volatile uint8 t g adc complete;

/* Functions for starting and stopping software triggered A/D conversion */
void R _S12AD0 SWTriggerStart (void) ;
void R _S12AD0_SWTriggerStop (void) ;

/* End user code. Do not edit comment generated here */
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Open the file ‘Config_S12AD0.c’ by double-clicking on it. Insert the following code in the user code area for
adding at the end of the file, resulting in the code shown below:

/* Start user code for adding. Do not edit comment generated here */

/********‘k‘k‘k*****************************~k************‘k‘k‘k‘k*‘k‘k‘k**********‘k****‘k‘k‘k
* Function Name: R S12AD0 SWTriggerStart

* Description : This function starts the ADO converter.

* Arguments : None

* Return Value : None
***************************~k~k~k*************************************************/

void R _S12AD0_SWTriggerStart (void)

{
IR(S12ADCO, S12ADIO) = 0U;
IEN(S12ADCO, S12ADIO) = 1U;
S12AD.ADCSR.BIT.ADST = 1U;

}

[ KKK KKK KKK K KKk ko ok ok K K K K K K K Kk ks ko ok kR R R KK K K K K Kk kR ok ok R R K R R R K K K K K K Kk ko kR ok ok ok ok ok ok

End of function R S12AD0 SWTriggerStart

*******************************************************************************/

VAR AR EEEEEEE R R R AR R EEE RSt A AR R EEEEE Rt E R R R Rk

* Function Name: R S12AD0 SWTriggerStop
* Description : This function stops the ADO converter.
* Arguments : None

* Return Value : None
*******************************************************************************/

void R _S12AD0_SWTriggerStop (void)
{
S12AD.ADCSR.BIT.ADST = 0U;
IEN (S12ADCO, S12ADIO) = 0U;
IR(S12ADCO, S12ADIO) = 0U;

}

VAREEEEEEEEE R R s R AR EEEEE R e EEEEE e E R e e

End of function R S12AD0 SWTriggerStop

*******************************************************************************/

/* End user code. Do not edit comment generated here */

Open the file ‘Config_S12ADO0_user.c’ and insert the following code in the user code area for global, resulting
in the code shown below:

/* Start user code for global. Do not edit comment generated here */

/* Flag indicates when A/D conversion is complete */
volatile uint8 t g adc_ complete;

/* End user code. Do not edit comment generated here */

Insert the following code in the user code area of the r_Config_S12ADO0_interrupt function, resulting in the
code shown below:

static void r Config S12AD0 interrupt (void)
{
/* Start user code for r_ Config S12AD0_interrupt. Do not edit comment generated here */

g_adc_complete = TRUE;

/* End user code. Do not edit comment generated here */

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in section 6. When any switch is pressed, the
program will perform an A/D conversion of the voltage level on the RV1 potentiometer line and display the
result on the LCD panel. Return to this point in the SC_Tutorial to add the UART user code.
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5.5 Debug Code Integration

API functions for trace debugging via the RSK serial port are provided with the RSK. Refer to the Tutorial
project folder created according to the Quick Start Guide procedure. Check that the following files are in the
src folder:

r_rsk_debug.c

r_rsk_debug.h

Copy these files in to the src folder below the workspace. Add these files into the project in the same way as
the LCD files as in section 5.3.

In the r_rsk_debug.h file, ensure the following macro definition is included:

/* Macro for definition of serial debug transmit function - user edits this */
#define SERIAL DEBUG WRITE (R SCI10 AsyncTransmit)

This macro is referenced in the r_rsk_debug.c file and allows easy re-direction of debug output if a different
debug interface is used.

5.6 UART Code Integration

5.6.1 SCI Code

In the CS+ Project Tree, expand the ‘Smart Configurator\Config_SCI10’ folder and open the file
‘Config_SCI10.h’ by double-clicking on it. Insert the following code in the user code area at the end of the file:
/* Start user code for function. Do not edit comment generated here */

/* Exported functions used to transmit a number of bytes and wait for completion */
MD STATUS R _SCI10_ AsyncTransmit (uint8 t * const tx buf, const uintl6_t tx num);

/* Character is used to receive key presses from PC terminal */
extern uint8 t g rx char;

/* End user code. Do not edit comment generated here */

Open the file ‘Config_SCI10_user.c’. Insert the following code in the user area for global near the beginning of
the file:

/* Start user code for global. Do not edit comment generated here */

/* Global used to receive a character from the PC terminal */
uint8 t g rx char;

/* Flag used locally to detect transmission complete */
static volatile uint8 t s SCI10_ txdone;

/* End user code. Do not edit comment generated here */

In the same file, insert the following code in the user code area inside the
r_Config_SCI10_callback_transmitend function:
static void r Config SCI10 callback transmitend (void)
{
/* Start user code for r Config SCI10 callback transmitend. Do not edit comment generated here */

s SCI10 txdone = TRUE;

/* End user code. Do not edit comment generated here */
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In the same file, insert the following code in the user code area
inside the r_Config_SCI10_callback_receiveend function:

static void r_Config SCI10_callback receiveend(void)

{

/* Start user code for r_Config SCI10_callback_receiveend. Do not edit comment generated here */

/* Check the contents of g rx char */
if (('c' == g rx char) || ('C' == g rx char))
{
g_adc_trigger = TRUE;
}

/* Set up SCI10 receive buffer and callback function again */
R Config SCI10 Serial Receive((uint8 t *)&g rx char, 1);

/* End user code. Do not edit comment generated here */

At the end of the file, in the user code area for adding, add the following function definition:

/* Start user code for adding. Do not edit comment generated here */

/*******************************************************************************

* Function Name: R_SCI10_AsyncTransmit

* Description : This function sends SCI10 data and waits for the transmit end flag.
* Arguments : tx buf -

* transfer buffer pointer

* tx num -

* buffer size

* Return Value : status -

* MD_OK or MD_ARGERROR

*******************************************************************************/
MD STATUS R SCI10 AsyncTransmit (uint8 t * const tx buf, const uintl6 t tx num)

{
MD_STATUS status = MD_OK;

/* Clear the flag before initiating a new transmission */
s SCI10 txdone = FALSE;

/* Send the data using the API */
status = R _Config SCI10_Serial_ Send(tx_buf, tx_num);

/* Wait for the transmit end flag */
while (FALSE == s_SCI10_txdone)
{
/* Wait */
}
return (status);

}

/*******************************************************************************

* End of function R SCI10 AsyncTransmit

R T R R e e S
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5.6.2 Main UART code

In the Project Tree, expand the ‘C Source Files’ folder and open the file ‘SC_Tutorial.c’. Add the following
declaration to above the ‘main’ function:

#include "r smc entry.h"
finclude "r okaya lcd.h"
#include "r cg userdefine.h"
#include "Config S12ADO.h"
#include "r rsk switch.h"
#include "r rsk debug.h"
#include "Config SCI10.h"

/* Variable for flagging user requested ADC conversion */
volatile uint8 t g adc trigger = FALSE;

/* Prototype declaration for cb switch press */
static void cb switch press (void);

/* Prototype declaration for get adc */
static uintl6_t get adc(void);

/* Prototype declaration for lcd display adc */
static void lcd display adc (const uintl6_t adc_result);

/* Prototype declaration for uart display adc */
static void uart display adc(const uint8 t adc count, const uintl6 t adc_result);

/* Variable to store the A/D conversion count for user display */
static uint8 t s_adc_count = 0;

R20UT5020EG0100 Rev.1.00 :{ENESAS Page 61 of 71
Jan.17.2022



Renesas Starter Kit for RX660

5. Completing the Tutorial Project

Add the following highlighted code to the main function:

void main (void)

{

/* Initialize the switch module */
R_SWITCH Tnit();

/* Set the call back function when SW1l or SW2 is pressed */
R SWITCH SetPressCallback(cb switch press);

/* Initialize the debug LCD */
R _LCD Init();

/* Displays

the application name on the debug LCD */

R_LCD Display(0, (uint8 t *)" RSKRX660 ");
R_LCD Display(l, (uint8 t *)" Tutorial ");
R_LCD Display(2, (uint8 t *)" Press Any Switch ");

/* Start the A/D converter */
R Config S12AD0 Start();

/* Set up SCI10 receive buffer and callback function */
R Config SCI10 Serial Receive((uint8 t *)&g rx char, 1);

/* Enable SCI10 operations */
R Config SCI10 Start():

while (10)
{

uintlé_t adc_result;

/* Wait

for user requested A/D conversion flag to be set

if (TRUE == g adc_trigger)

{

/* Call the function to perform an A/D conversion */
adc_result = get_adc();

/* Display the result on the LCD */
lcd display_adc(adc_result);

/* Increment the s adc_count */

if
{

}

(16 == (++s_adc_count))

s_adc_count = 0;

/* Send the result to the UART */

uart display adc(s_adc_count, adc result);

/* Reset the flag */
g_adc_trigger = FALSE;

}

/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */

else if

{

(TRUE == g_adc_complete)

/* Get the result of the A/D conversion */

R Config S12AD0O_Get ValueResult (ADCHANNELO,

/* Display the result on the LCD */
lcd display adc(adc_result);

/* Increment the s adc count */

if
{

}

(16 == (++s_adc_count))

s_adc_count = 0;

/* Send the result to the UART */
uart display adc(s_adc count, adc result);

/* Reset the flag */
g_adc_complete = FALSE;

}

else

{

/* do nothing */

}

&adc_result);

(SW1 or SW2) x/
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Then, add the following function definition in the end of the file:

/******************************************************************************

* Function Name : uart display adc

* Description : Converts adc result to a string and sends it to the UARTL.
* Argument : uint8 t : adc_count

* uintlé_t: adc result

* Return value : none

******************************************************************************/
static void uart display adc (const uint8 t adc_count, const uintl6_t adc_result)

{
/* Declare a temporary variable */
char t tmp;

/* Declare temporary character string */
char t uart buffer[] = "ADC xH Value: xxxH\r\n";

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

tmp = (char t) (adc_count & 0x000F);

uart buffer[4] = (tmp < 0x0A) ? (tmp + 0x30) : (tmp + 0x37);
tmp = (char_ t) ((adc_result & 0x0F00) >> 8);

uart buffer[14] = (tmp < 0x0A) ? (tmp + 0x30) : (tmp + 0x37);
tmp = (char t) ((adc_result & 0x00F0) >> 4);

uart buffer[15] = (tmp < 0x0A) ? (tmp + 0x30) : (tmp + 0x37);
tmp = (char_ t) (adc_result & 0x000F);

uart buffer[16] = (tmp < 0x0A) ? (tmp + 0x30) : (tmp + 0x37);

/* Send the string to the UART */
r debug print (uart buffer);

}

VAR R AR EEEEE RS R EEEE e AR AR R R R R

* End of function uart display adc
******************************************************************************/

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in section 6. Connect the RSK G1CUSBO port
to a USB port on a PC. If this is the first time the RSK has been connected to the PC then a device driver will
be installed automatically. Open Device Manager, the virtual COM port will be appeared under 'Port (COM &

LPT)" as 'RSK USB Serial Port (COMXx)', where x is a number.

Open a terminal program, such as HyperTerminal, on the PC with the same settings as for SCI10 (Baud Rate:

19200, Data Length: 8, Parity Bit: None, Stop Bit: 1, Flow Control: None).

When any switch is pressed, or when ‘c’ is sent via the COM port, the program will perform an A/D conversion
of the voltage level on the RV1 potentiometer line and display the result on the LCD panel and send the result

to the PC terminal program via the SCI10.
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5.7 LED Code Integration

In the Project Tree, expand the ‘C Source Files’ folder and open the file ‘SC_Tutorial.c’. Add the following
declaration to the above the ‘main’ function:

#include "r smc entry.h"
#include "r okaya lcd.h"
#include "r cg userdefine.h"
#include "Config S12ADO.h"
#include "r rsk switch.h"
#include "r rsk debug.h"
#include "Config SCI10.h"
#include "rskrx660def.h"

/* Variable for flagging user requested ADC conversion */
volatile uint8 t g adc trigger = FALSE;

/* Prototype declaration for cb_switch press */
static void cb switch press (void);

/* Prototype declaration for get adc */
static uintl6_t get adc(void);

/* Prototype declaration for lcd display adc */
static void lcd display adc (const uintl6_t adc_result);

/* Prototype declaration for uart display adc */
static void uart display adc(const uint8 t adc count, const uintl6 t adc_result);

/* Variable to store the A/D conversion count for user display */
static uint8 t s adc count = 0;

/* Prototype declaration for led display count */
static void led display count (const uint8 t count);

Add the following highlighted code to the main function:

void main (void)

{
/* Initialize the switch module */
R_SWITCH Tnit();

/* Set the call back function when SW1 or SW2 is pressed */
R _SWITCH SetPressCallback(cb switch press);

/* Initialize the debug LCD */
R LCD Init();

/* Displays the application name on the debug LCD */
R _LCD Display (0, (uint8 t *)" RSKRX660 ");

R _LCD Display(l, (uint8 t *)" Tutorial ");

R_LCD Display(2, (uint8 t *)" Press Any Switch ");

/* Start the A/D converter */
R Config S12AD0 Start();

/* Set up SCI10 receive buffer and callback function */
R Config SCI10 Serial Receive((uint8 t *)&g rx char, 1);

/* Enable SCI10 operations */
R Config SCI10 Start();

while (10)
{

uintl6é t adc result;

/* Wait for user requested A/D conversion flag to be set (SW1 or SW2) */
if (TRUE == g adc_trigger)
{

/* Call the function to perform an A/D conversion */

adc_result = get adc();

/* Display the result on the LCD */
lcd display adc(adc result);
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/* Increment the s _adc count and display using the LEDs */
if (16 == (++s_adc_count))
{
s_adc_count = 0;
}

led display_count (s_adc_count) ;

/* Send the result to the UART */

uart display adc(s_adc_count, adc result);

/* Reset the flag */

g _adc_trigger = FALSE;
}
/* SW3 is directly wired into the ADTRGOn pin so will

cause the interrupt to fire */
else if (TRUE == g adc_complete)
{

/* Get the result of the A/D conversion */

R _Config S12AD0O_Get ValueResult (ADCHANNELO, &adc_result);

/* Display the result on the LCD */
lcd display adc(adc_result);

/* Increment the s_adc_count and display using the LEDs */
if (16 == (++s_adc_count))
{
s_adc_count = 0;
}

led display count (s_adc_count) ;

/* Send the result to the UART */
uart display adc(s_adc count, adc result);
/* Reset the flag */
g_adc_complete = FALSE;
}
else
{
/* do nothing */
}

Then, add the following function definition at the end of the file:

/******************************************************************************

* Function Name : led display count

* Description : Converts count to binary and displays on 4 LEDS0-3
* Argument : uint8_t count

* Return value : none

******************************************************************************/

static void led display count (const uint8 t count)

{

/* Set LEDs according to lower nibble of count parameter */

LEDO = (uint8_t) ((count & 0x01) ? LED ON : LED OFF);
LED1 = (uint8 t) ((count & 0x02) ? LED ON : LED OFF);
LED2 = (uint8_t) ((count & 0x04) ? LED ON : LED OFF);
LED3 = (uint8_t) ((count & 0x08) 2 LED ON : LED OFF);

}

[k kK ok ok ok K K K A A K K K Kk ok kR ok kR R A A R A K Kk kR kR ok kK R AR K K K Kk ks ok ok ok ok ok ok R R A K K Kk ok ko kR ok ok ok ok ok

* End of function led display count
******************************************************************************/

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in section 6. The code will perform the same

but now the LEDs will display the s_adc_count in binary form.
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6. Debugging the Project

6. Debugging the Project

e In the ‘Project Tree’ pane, right-click the
‘RX Simulator (Debug Tool). Select
‘Using Debug Tool -> RX E2 Lite’.

Project Tree I x
t @ 2 |&
Bﬁ SC Tutorial (Project)
R5F56608HxFB (Microcontroller)
. __J Smart Configurator (Design Tool)
-4, CC-RX (Build Tool)
Y2 R Simulator (Debug Toc'

= f\.‘:' Program Analyzer (Anal !| Using Debug Tool e
-3 File % Property RX E2 Lite |
|_E Smart Configurator RX E1(Serial)
I_E C Source Files :
|_E Dependencies RX E1(JTAG)
R E20(Serial)
RX E20(JTAG)
RX Simulator

e Double-click ‘RX E2 Lite (Debug Tool)' to
display the debugger tool properties.
Under ‘Clock’, change the main clock
frequency to 24MHz, Communications
method ‘FINE’ and operating frequency to
120MHz”

e Under ‘Connection with Target Board’,
change ‘Power target from the emulator.
(MAX 200mA)’ to ‘Yes’.

e All other settings can remain at their
defaults.

& Property

& RX E2 Lite Property
+ Internal ROM/RAM
Size of internal ROM[KBytes] 1024

Size of inte [KBytes]

Size of Da

v Ciod

Main clock source EXTAL
Main clock frequency[MHz) 24,0000 I
Operating frequency[MHz] 120.0000

Allow changing of the clock source on writing internal flash memory No
» Connection with Emulator
Emulator serial No.

w Connection with T: Board
[Power target from the emulator, (MAX 200ma) Yes |

IComrr.-unic ations method FINE I

FINE baud rate[bps] 1500000

e Connect the E2 Lite to the PC and the
RSK E2 Lite connector. Connect the
Pmod LCD to the PMOD1 connector.

e From the ‘Debug’ menu select ‘Download’
to start the debug session and download
code to the target.
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7. Running the Smart Configurator Tutorial

71 Running the Tutorial

Once the program has been downloaded onto the RSK device, the program can be executed.
Click the ‘Go’ button or press F5 to begin the program from the current program counter I#P:I
position. It is recommended that you run through the program once first, and then continue to =
the Tutorial manual to review the code.
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8. Additional Information

8. Additional Information

Technical Support

Help

For details on how to use CS+, refer to the help Window | Help|
file by opening CS+, then selecting Help > Help —= |®
Contents from the menu bar. & & @

H

BEOLE NS

—
(Pn]
S

Cpen Help for Main window
How to Access Help
Cne Point Advice...

Tuterial

Browse Reneszas Electronics Microcontrollers Web

Privacy Settings...
Detail Version Information...
Check for Updates...

Launch License Manager...

About...

Fi

For information about the RX660 group microcontroller refer to ‘RX660 Group User’s Manual: Hardware’.

For information about the RX assembly language, refer to ‘RX Family User’s Manual: Software’.

Technical Contact Details
America: techsupport.america@renesas.com

Europe: https://www.renesas.com/eu/en/support/contact.html

Global & Japan: https://www.renesas.com/support/contact.html

General information on this product can be found on the Renesas website at:

https://www.renesas.com/rskrx660

General information on Renesas microcontrollers can be found on the Renesas website at:

https://www.renesas.com/

Trademarks

All brand or product names used in this manual are trademarks or registered trademarks of their respective

companies or organisations.

Copyright

This document may be, wholly or partially, subject to change without notice. All rights reserved. Duplication of
this document, either in whole or part is prohibited without the written permission of Renesas Electronics

Europe GmbH.

© 2022 Renesas Electronics Europe GmbH. All rights reserved.
© 2022 Renesas Electronics Corporation. All rights reserved.
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